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Document Disclaimer
The information in this document has been carefully checked and is believed to be reliable. 
However, no responsibility can be assumed for inaccuracies that may not have been 
detected. LeCroy reserves the right to revise the information in this document without 
notice or penalty.

Changes or Modifications
Any change or modification not expressly approved by LeCroy voids the user’s authority 
to operate this equipment.

Trademarks and Servicemarks
CATC, Advisor, USBTracer, USBTrainer, USBMobile, USBMobileHS, and BusEngine are 
trademarks of LeCroy. 

Microsoft, Windows 98SE, Windows Me, Windows 2000, Windows XP, and Windows NT 
are registered trademarks of Microsoft Inc.

All other trademarks are property of their respective companies.

Copyright
Copyright © 2006, LeCroy; All Rights Reserved. This document may be printed and 
reproduced without additional permission, but all copies should contain this copyright 
notice. 

FCC Conformance Statement
This equipment has been tested and found to comply with the limits for a Class A digital 
device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference when the equipment is operated in a 
commercial environment. This equipment generates, uses, and can radiate radio frequency 
energy and, if not installed and used in accordance with the instruction manual, may cause 
harmful interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference in which case the user is required to correct the 
interference at his own expense. The end user of this product should be aware that any 
changes or modifications made to this equipment without the approval of LeCroy could 
result in the product not meeting the Class A limits, in which case the FCC could void the 
user's authority to operate the equipment.

EU Conformance Statement
This equipment complies with the EMC Directive 89/336/EEC and the Low Voltage 
Directive 73/23/EEC, and their associated amendments for Class A Information 
Technology Equipment. It has been tested and found to comply with EN55022:1998 Class 
A (EN61000-3-2:1998, EN61000-3-3:1995) and EN55024:1998 (EN61000-4-2:1998, 
EN61000-4-3:1996, EN61000-4-4:1996, EN61000-4-5:1996, EN61000-4-6:1997, 
EN61000-4-11:1998), and EN60950:1999. In a domestic environment this product may 
cause radio interference in which case the user may be required to take adequate measures.

Part number: 730-0020-00
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1.  Overview
The LeCroy USBTracer™ USB 2.0 Design & Verification System is the 
latest in LeCroy’s broad portfolio of analysis tools. As a fifth generation 
product, it builds upon solid knowledge of the needs of the USB 
development and test communities. The result is a USB bus & protocol 
Analyzer with unprecedented functionality, unparalleled flexibility, and 
uncompromising user friendliness. The USBTracer interfaces with standard 
USB cables and connections to capture and display all speeds of USB bus 
traffic. 

1.1  General Description
USBTracer™ is a hardware module that installs into the LeCroy Universal 
Protocol Analyzer System. Once installed, USBTracer can be easily 
configured and controlled by a portable or desktop PC connected via its 
USB port. USBTracer provides customers with the familiar "CATC Trace" 
user interface that is the de facto industry standard for documenting the 
performance of high-speed serial protocols. 

USBTracer is a non-intrusive testing tool for the USB protocol providing 
traffic capture and analysis. Hardware triggering allows real-time events to 
be captured. Hardware filtering allows the different types of packets to be 
filtered in or out of the recording. Filtering allows users to focus recordings 
on events of interest and to preserve recording memory so that the recording 
time can be extended.
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Recorded data is displayed in colored graphics in a trace viewer application. 
This application has advanced search and viewing capabilities that allow 
you to quickly locate specific data, errors and other desired conditions, 
thereby focussing the user’s attention on events of interest. 

USBTracer functions with any personal computer using the Microsoft® 
Windows® 98SE, 2000, ME, or XP operating system and equipped with a 
functional USB interface. 

The Analyzer is a plug-in module that is installed into a LeCroy Universal 
Protocol Analyzer System (UPAS). Together, the Analyzer and UPAS are 
controlled from a personal computer USB port across a USB connection. 

USBTracer provides on-the-fly detection of and triggering on such events 
as Tokens and Errors. Whether recording manually or with a specified 
trigger condition, USBTracer continuously records the link data in a 
wrap-around fashion until manually stopped or until the Trigger Event is 
detected and a specified post-Trigger amount of link data is recorded.

Upon detection of a triggering event, the analyzer continues to record data 
up to a point specified by the user. Real-time detection of events can be 
individually enabled or disabled to allow triggering on events as they 
happen. This includes predefined exception or error conditions and a 
user-defined set of trigger events. The unit can also be triggered by an 
externally supplied signal. An external DB-25 connector provides a path for 
externally supplied data or timing data to be recorded along with traffic.
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This DB-25 connector also provides a path for USBTracer to transmit 
externally the software trigger signal or a user-defined event for purposes of 
probing and use by other circuitry.

The USBTracer software provides powerful search functions that enable 
investigation of particular events and allow the software to identify and 
highlight specific events. In addition to immediate analysis, you can print 
any part of the data. Use the Save As feature to save the data on disk for later 
viewing. The program also provides a variety of timing information and 
data analysis reports.

Please refer to the Universal Serial Bus Specification, version 2.0 for details 
on the protocol. The USB specification is available from the USB 
Implementers Forum (USB-IF) at: 

1.2  Features

General
• Fully compliant with USB specification revision 2.0.

• Flexible design - reconfigurable hardware for future enhancements.

• Convenient modular system architecture with field upgradeable firmware 
and recording engine.

• Supports all USB speeds (480 Mb/s, 12Mb/s and 1.5 Mb/s).

• On the UPAS 2500H platform, Hi-Speed recording and generation 
requires an optional, separately priced key. See your LeCroy 
representative for more information.

• Dual recording channels aid in the development of multiple speed 
functions upstream and downstream of speed-matching hub or 
transaction translator.

• User friendly "CATC Trace" interface that displays bus traffic using 
color and graphics.

• Trace Viewer available as free non-recording, view-only software.

• Online and context-sensitive help.

• Power-on self-diagnostics.

• Three year warranty and hot-line customer support.

USB Implementers Forum
1730 SW Skyline Blvd. 
Suite 203
Portland, OR 97221

Tel: +1/503.296.9892
Fax: +1/503.297.1090
Web: http://www.usb.org/
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• Can be used in conjunction with the LeCroy USBTrainer USB Traffic 
Generator hardware module to create a fully customizable USB test 
platform.

Physical Components
• Hardware module for the LeCroy Universal Protocol Analyzer System.

• Operated by any desktop or portable Microsoft Windows 98, 98SE, 
2000, ME, or XP computer with USB capability.

• Convenient Plug-and-Play USB installation.

• High impedance tap inserts non-intrusively in any branch of a USB 
system.

• 512 MB of physical data recording memory.

• Two all speed recording channels, which include Low, Full, or Hi-Speed.

• Full-Speed USB connection to desktop or portable host PC. Hi-Speed on 
UPAS 2500H platform.

• Internal wide-range AC power supply.

• Break-out board (included) - used to interface to external test equipment.

Recording Options
• Versatile triggering - bit-wise value and mask data patterns up to sixteen 

bytes wide for Setup transactions and data packets.

• Triggering on new High-speed PIDs and split transaction special tokens 
(ERR, SPLIT, PING, NYET, DATA2, and MDATA).

• CATC Trace displays and enumerates High-speed Micro Frames.

• Three forms of triggering: Snapshot, Manual and Event.

• Transaction sequencer allows triggering on a token qualified by a data 
pattern and /or specific handshake or alternately transactions can be 
filtered (i.e., NAK’d transactions).

• Advanced triggering with event counting and sequencing.

• Dedicated trigger for recording input and output used to interface to 
external test equipment.

• Triggering on multiple error conditions - PID bad, bit stuffing bad, CRC 
bad, end-of-packet bad, babble, loss of activity, frame length violation, 
time-out or turn-around violation, data toggle violation, Token, Bus 
Conditions, Data Length, excessive empty frames.

• Real-time traffic capture filtering and data packet truncation variable up 
to 256 bytes. 

• Adjustable buffer size from 0.4 MB to 512 MB.
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Display Options
• Utilizes "CATC Trace" graphical display of bus packets, transactions, 

split transactions and transfers.

• Numerous packets and transactions can be grouped under a single 
transfer while quickly decoding all essential information.

• Decoding of split transactions up and down stream of a transaction 
translator is accomplished with a special hierarchical view.

• Variety of reports provided to summarize key statistics and conditions of 
interest with the ability to jump to the selected item in the trace display.

• Flexible input signaling can be recorded with the CATC Trace.

• Trace Viewer is backward compatible with Advisor™, Chief™, 
Inspector™, and Detective™ trace files.

• User-friendly trigger position indicated by different colors of pre- and 
post-trigger packet color.

• Markers can be set to assist with navigation and time calculations. 

• Hide start-of-frame (SOF) packets as well as any packet or transaction.

• Search for a specific PID.

• Detects & alerts the user to every potential bus error, protocol violation, 
& combinations thereof.

• High resolution, accurate time stamping of bus packets, timing 
measurement and analysis functions.

• Extensive search and packet hiding capabilities.

• Comprehensive device class decoding plus user defined protocol 
decoding.

Traffic Generation

• Traffic generation capability available as an add-on module for the 
Universal Protocol Analyzer System called USBTrainer™.

Hi-Speed Slow Clock

The ability to Trace and Generate Hi-Speed traffic at fractional (slow) clock 
rate is available on both USBTracer platforms (2500 and 2500H), and can 
be purchased via a License Key. Contact LeCroy for more information. 

1.3  Graphical Bus Traffic Display
The USBTracer transaction displays use color and graphics to show the 
captured transactions in an immediate, understandable and useful format.
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Packets are shown on separate rows, with their individual fields both labeled 
and color-coded. Packets are also numbered (sequentially, as recorded), 
time-stamped. Protocol errors are automatically detected and visibly 
highlighted in red.

The display is customizable, allowing the user to control the color scheme 
and the formatting of field contents. A hide feature allows users to enable 
the suppression of SOF packets and user defined packets or fields that might 
be uninteresting in a given context. Display formats can be named and saved 
for later use. Pop-up "tool-tips" annotate packet fields with even more 
detailed information about their contents. 

The display software operates independently of the hardware, allowing it to 
function as a stand-alone "trace viewer" that is freely distributed. 

1.4  Accurate Time Management
USBTracer uses internal counter/timer circuitry to enable a reliable, 
accurate (16.67 ns resolution) time stamping of recorded bus traffic. This 
timing information is displayed in the trace and in measurement and 
analysis functions. Any number of markers can be added by the user to 
denote specific packets, and further timing measurements can be made from 
one marker to another or from marker to trigger. All time fields are 
presented as a time stamp, idle time, bit time or in a new time delta in either 
decimal or hexadecimal format.
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An essential feature of time management is that idle traffic does not 
consume the analyzer memory. Because of this unique technology, accurate 
timing calculations can be made while still preserving valuable recording 
memory for important bus traffic.

1.5  Comprehensive Error Detection and Analysis
USBTracer detects and alerts the user to every potential bus error, protocol 
violation and/or combination thereof. The analyzer contains circuitry in the 
BusEngine™ to perform real-time triggering on multiple error conditions, 
such as PID bad, bit stuffing bad, header or data CRC bad, end-of-packet 
bad, babble, loss of activity, frame length violation, time-out or turn-around 
violation and data toggle violation. The analyzer program highlights all the 
hardware detected errors and further examines the trace file for additional 
protocol errors, including wrong packet length, data payload violation, and 
packet termination not on a byte boundary.

1.6  Real-Time Event Triggering and Capture Filtering
No attribute of a bus and protocol analyzer is more important than its 
capacity for extracting useful information from a crowded stream of bus 
traffic. The ability to accurately identify and selectively record transactions 
of interest is the trait most valuable to the user. USBTracer offers a unique 
approach to this challenge. By using a set of "recording resources", over a 
dozen configureable hardware building blocks, each can be optimized to 
perform a particular activity appropriate to the task. A recording resource 
can independently await an initialization signal, monitor its external 
environment (external signals, other resources) in search of a particular 
event and take a subsequent action (triggering, inclusive or exclusive 
filtering, counting, etc.). Under control of the user interface, these resources 
can be selected, configured and combined to search for complex trigger 
conditions and selectively capture the associated transactions.

Thus, as well as triggering on basic events, such as specific bus conditions, 
packet identifiers (PID), etc. (see the Specifications section for a complete 
list), USBTracer can easily manage the most challenging requirements. For 
example: "trigger on the fifth occurrence of a SETUP Token device number 
nine", or "trigger on a SET INTERFACE request, following a specified 
eight-byte bulk data pattern match from this scanner, and do not capture any 
start-of-frame (SOF) packets."

The user can set the size of the recording memory, specify the pre- and 
post-trigger capture ratio, and truncate large data packets up to 256 bytes.
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1.7  Advanced Event Counting & Sequencing
The count and sequence options define rules for data recording sessions. 
These options provide the ability to configure and control the order of 
events that have been selected for triggering or filtering. There are two 
counters and a restart option that causes the sequencing to start again.

By utilizing this feature, designers can specify a specific sequence of up to 
seven events that must occur before the analyzer triggers and finishes 
capturing data. This allows designers to pinpoint certain types of events for 
recording. Without this feature, designers must scroll through potentially 
megabytes of recorded data to locate a specific sequence or occurrence of a 
sequence that can take hours to locate before being able to begin analyzing 
the data of interest.

1.8  BusEngine Technology
The LeCroy BusEngine Technology is at the heart of the new USBTracer 
Analyzer. The BusEngine core uses state-of-the-art Electrically 
Programmable Logic Device (EPLD) technology and incorporates both the 
real-time recording engine and the configurable building blocks that 
implement data/state/error detection, triggering, capture filtering, external 
signal monitoring, and event counting & sequencing. Like the 
flash-memory-based firmware that controls its operation, all BusEngine 
logic is fully field upgradeable, using configuration files.
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1.9  Specifications
USBTracer is a hardware module that installs into the Universal Protocol 
Analyzer System. The following specifications describe a combined 
USBTracer/Universal Protocol Analyzer System. 

Package 

Connectors 

Weight 

Power Requirements

90-254VAC, 47-63Hz (universal input), 100W maximum 

Environmental Conditions 

Probing Characteristics 

Switches 

UPAS 12.2 x 12.2 x 3.5 inches
(31.1 x 31.1 x 8.9 cm)

USBTracer Plug-in 4.5 x 6.7 x 1.3 inches
(11.3 x 17.0 x 3.2 cm)

UPAS AC power connection
External trigger connection
Host connection (USB, type "B")

UPAS

USBTracer Plug-in

7.5 lb. (3.4 kg)
1.0 lb. (0.5 kg)

Operating Range 0 to 55 °C (32 to 131 °F)
Storage Range -20 to 80 °C (-4 to 176 °F)
Humidity 10 to 90%, non-condensing

Connection High Speed USB Connectors
Standard cables

Power On/off
Manual Trigger When pressed forces a trigger event
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Indicators (LEDs)

UPAS 

Recording Memory Size 

512 M x 8-bit DRAM for traffic data capture, timing, state and other data.

Host Compatibility
Works with any PC equipped with a functioning USB port and running the 
Microsoft Windows 98SE, ME, 2000, or XP operating system. 

Required Setup
Microsoft Internet Explorer, Version 5 or newer. 

Hardware
Processor: For optimum performance, use processors of the Intel Pentium 
III/Pentium 4 family, AMD Athlon/Duron family, or other compatible 
processors with clock speed of 500mHz or higher (Processors of the Intel 
Pentium II/Celeron family or AMD K6 family with clock speed of 300mHz 
is a minimum). 

Memory: For the best performance, it is recommended to have physical 
RAM twice the size of the recording buffer setup - 512MB or more 
(minimum of 128MB of RAM).

Hard Disk: At least 20MB of free hard disk space is required for the 
installation. Additional disk space is needed for storing the recorded data in 
files during the recordings process (can be as much as 500MB when 
recording a full buffer size).

Display: Resolution of 1024 x 768 with at least 16-bit color is 
recommended (resolution of 800 × 600 with 16-bit color is a minimum).

Power (PWR): Illuminated when the analyzer is powered on.
Status (STATUS): Illuminated solid during self test, blinking during 

failure, off when the analyzer is functioning properly.
Recording (REC): Illuminated when the analyzer is actively recording 

traffic data.
Triggered (TRG): Illuminated during power-on testing and when the 

analyzer has detected a valid trigger condition.
Uploading (UPLD): Illuminated when the analyzer is uploading its 

recording memory to the Host PC for displaying the 
CATC Trace.
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Connectivity: A USB interface is required to connect to the USBTracer 
analyzer. This is not a requirement if the application is going to be used only 
as a viewer.

Power Cord Set
Cord Manufacturer and Models: 

• 180-0005-00 Quail 5000.079 UL, CSA

• 180-0013-00 Quail 8500.098 VDE, KEMA, CEBERC, NEMDO, 
DEMDO, SETI, OVE, SEV

• 180-0014-00 Quail 9650.098 ASTA

USBTracers on the UPAS 2500H Platform
UPAS 2500H USBTracer is a USB 2.0 Certified Hi-Speed Device. To 
upload at Hi-Speed, you must have a USB 2.0 Certified Host Controller and 
be running Microsoft Windows 2000 SP3 or Windows XP.

The UPAS 2500H ships in one of two configurations: Classic and Hi-Speed. 
The Classic version can trace and generate traffic at Low and Full Speeds. 
The Hi-Speed version can trace and generate traffic at All speeds: Low, 
Full, and Hi.

The Classic model may be upgraded to a Hi-Speed model by the purchase 
of a License Key from LeCroy. Contact your LeCroy representative for 
more information.

Note: The UPAS 2500 and UPAS 2500H products include internal 1.1 
and 2.0 Hubs. You might see the drivers for these generic hubs 
being installed upon the initial plug-in. 
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2.  Quick Installation
USBTracer™ is factory-installed hardware module that is sold as part of the 
LeCroy Universal Protocol Analyzer System. 

The Universal Protocol Analyzer System (UPAS) together with the 
USBTracer module and associated software are easily installed on most 
Microsoft® Windows®-based personal computer systems. You can begin 
making USB recordings after following these initial steps. However, if you 
are new to protocol analyzers, or are unsure about what to do after reading 
the Quick Installation instructions, or if your analyzer does not work after 
you follow these instructions, read through the subsequent sections in this 
manual.

Step 1 Connect the AC power cable to the rear of the Analyzer.

Step 2 Connect the USB port on the back of the Analyzer to the PC using 
the LONG (6-foot/2-meter) USB cable.

Step 3 Insert the CD.

Step 4 Turn on the power switch on the rear of the Analyzer.

Step 5 Click Next when you see the window of "Add New Hardware 
Wizard."

Step 6 Follow the on-screen Plug-and-Play instructions.

Step 7 Click Finish when you see the message that says "Windows has 
finished installing the software that your new hardware requires" 
and the file "Tracer.inf" has been installed in your PC.

Step 8 Run the program a:\setup and follow the on-screen instructions.

Step 9 Select About USBTracer... from the Help menu.

If you can see all of the information listed below, you can record a 
trace:

• USBTracer Software Version

• USBTracer Firmware Version

• BusEngine™ Version

• Unit Serial Number
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2.1  Installing the Software and Starting the Program
Step 1 Insert the USBTracer CD into the CD-ROM drive on the host PC 

and follow the on-screen instructions to install the USBTracer 
application.

Step 2 To start the application, launch the LeCroy USBTracer program 
from the Start Menu: 

Start > Programs > LeCroy > LeCroy USBTracer

The USBTracer main window opens: 

2.2  Your First USB Recording
After installing and launching the software, you can test USBTracer by 
performing the following steps: 

Step 1 Connect a USB cable to each of the two connectors on the 
USBTracer module, then connect the other ends to the USB device 
under test and USB host system.

Step 2 Select Recording Options under Setup on the Menu Bar.
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Step 3 Select the General tab to display the following dialog box showing 
factory default settings such as Snapshot and 4 Mbytes buffer size. 
For the first recording, you can leave these settings unchanged. 

Step 4 Click OK to activate the recording options you selected.

Step 5 Turn on the USB devices that are to be tested and cause them to 
generate USB traffic.

Step 6 Click on the Tool Bar.

USBTracer starts to record the USB traffic immediately. After 
4 Mbytes of traffic are recorded, the analyzer uploads the data and 
displays the packets in the trace window.

Step 7 To terminate recording before the snapshot automatically

 completes, click on the Tool Bar.

When the recording session is finished, the traffic is uploaded from 
the Analyzer to the hard drive on your PC as a file named data.usb 
or the name you assigned as the default filename. While the file is 
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being uploaded, you should see a brown progress bar at the bottom 
of the screen. When the bar disappears, it indicates that the data has 
been uploaded to disk.

Step 8 To save a current recording for future reference, select Save As 
under File on the Menu Bar.

OR

Click on the Tool Bar to display the standard Save As screen.

Step 9 Give the recording a unique name and save it to the appropriate 
directory.

Capturing Your First Trace

After a moment, the recording terminates and the results display: 
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Trace View Features

• The USBTracer packet view display makes extensive use of color 
and graphics to fully document the captured traffic.

• Packets are shown on separate rows, with their individual fields 
both labeled and color coded. 

• Packets are numbered (sequentially, as recorded), time-stamped 
(with a resolution of 16.67 ns), and highlighted to show the 
transmitted speed (low-speed, full-speed or high-speed).

• Display formats can be named and saved for later use. 

• Pop-up Tool Tips annotate packet fields with detailed information 
about their contents

• Data fields can be collapsed to occupy minimal space in the display 
(which can in turn be zoomed in and out to optimize screen 
utilization). 

The display software can operate independent of the hardware and so can 
function as a stand-alone Trace Viewer that may be freely distributed. 
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3.  Detailed Installation

3.1  System Components/Packing List
• One stand-alone USBTracer™ Analyzer module

• Five USB cables

• USBTracer software program installation diskettes

• Product documentation

3.2  The Installed USBTracer Unit
USBTracer is a module that inserts into the left slot on the LeCroy 
Universal Protocol Analyzer System (UPAS). Once installed, the 
USBTracer Analyzer activates the user-accessible controls and LEDs on the 
front and rear panels of the UPAS. 

Figure 1 Front Panel
 

Figure 2 Rear Panel

LED and Button Descriptions

The following section describes the LEDs, buttons, and connectors on the 
module and UPAS.
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LEDs on the Far Left Side of the UPAS
• Green PWR (Power) indicator LED for UPAS: Lights when the 

unit power is switched on.

• Red Status indicator LED for UPAS: Lights during boot up.

LEDs and Button on the UPAS under the Left Module Slot
The LEDs and button on the UPAS enclosure under the left module slot 
function in conjunction with the USBTracer module inserted above it: 

• Green REC (Recording) LED: Lights when the unit is recording. 

• Orange TRG (Triggered) LED: Lights when the unit triggers on an 
event.

• Green UPLD (Upload): Lights when unit is uploading data to PC.

• Manual Trigger push-button: Allows a manual Trace capture. 

LEDs and Button on the UPAS under the Right Module Slot
The LEDs and button under the right module slot are reserved for LeCroy 
generator modules such as the USBTrainer USB Traffic Generator 
(described in Chapter 11: Traffic Generation with USBTrainer on page 
151): 

• Green HS: Illuminates when Hi-Speed is being generated.

• Orange Classic: Illuminates when Full or Low Speed is being 
generated. Classic also illuminates during power-on testing and is 
turned off at the end of the power on cycle. If the LED blinks at the 
end of this cycle, the hardware is faulty.

• Green Intelliframe: Illuminates when Intelliframe traffic is being 
generated using Intelliframe mode, an intelligent adaptive traffic 
mode. If off, the generation is in Bitstream mode. See the section on 
"Traffic Generation Modes: Bitstream versus Intelliframe" in 
Chapter 11 for more information.

• Start/Stop: Push-button allows manual Trace capture.

• Wide range AC connector module: 

— Power socket

— Power on/off switch

— Enclosed 5x20 mm 2.0A 250 V fast acting glass fuse

Warning For continued protection against fire, replace fuse only with the type 
and rating specified above.
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• Two External Ports marked Ext. 1 and Ext. 2.

• USB type B host computer connector

• Data In/Out DB-25 (25-pin) external interface connector 

Warning Do not open the UPAS enclosure. There are no operator serviceable 
parts inside. Refer servicing to LeCroy.

3.3  USBTracer System Setup
USBTracer is a module that inserts into the Universal Protocol Analyzer 
System. The UPAS, in turn, is connected and controlled by a desktop or 
laptop PC via a USB connection. 

To set up the system hardware: 

• Insert the USBTracer module into the UPAS.

• Connect the Analyzer to an AC power source.

• Connect to the analyzing PC via USB.

• Connect USB cable to the device under test.

3.4  AC Power Source
Step 1 Connect the Analyzer box to a 100-volt to 240-volt, 50 Hz to 60 Hz, 

120 W power outlet using the provided power cord.

Note The Analyzer is capable of supporting supply voltages between 
100-volt and 240-volt, 50 Hz or 60 Hz, thus supporting all known 
supply voltages around the world.

Step 2 Use the power switch located on the rear panel to turn the analyzer 
unit on and off.

Note At power-on, the analyzer initializes itself in approximately 25 
seconds and performs an exhaustive self-diagnostic that lasts about 
45 seconds. The Status LED illuminates during the power-on testing 
and turns off when testing is finished. If the diagnostics fail, the 
Status LED blinks, indicating a hardware failure. If this occurs, call 
LeCroy Customer Support for assistance.
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3.5  External Interface Breakout Board
The External Interface Breakout Board is an accessory that allows 
convenient access to several potentially useful standard, LV TTL output and 
input signals. It also offers a simple way to connect logic analyzers or other 
tools to the USBTracer Analyzer unit. Six ground pins and one 5-volt pin 
are provided.

Figure 3 External Interface Breakout Board

The Breakout Board connects via a cable to the Data In/Out connector 
located on the rear of the analyzer box. Each signaling pin is isolated by a 
100Ω series resistor and a buffer inside the Analyzer box. 

Figure 4 Data In/Out Connector (on cable)
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Pin-Outs for the Data In/Out Connector
Table 11 lists the pin-out and signal descriptions for the Data In/Out 
connector on a cable that connects to the Breakout board. 

Table 1 Data In/Out Connector – Pin-Out 

Note (*) Pins 4 and 17 have the same function. They allow external signals 
to be used to cause triggering or recording. Pins 3 and 16 are used to 
transmit output signals.

Prototype Rework Area
The Breakout Board contains a prototype rework area for making custom 
circuits for rapid development. The area consists of plated-through holes, 20 
columns wide by 27 rows long. The top row of holes is connected to GND 
and the bottom row is connected to +5V. The remaining holes are not 
connected. Use the rework area to insert custom components and wire-wrap 
their respective signal, power, and ground pins. 

Pin Signal Name Signal Description

1 RSV Reserved

2 GND Ground

3 GP OUT General Purpose Output

4 TRG IN 1 Trigger In 1

5 GND Ground

6 DATA 6 Data 6

7 DATA 4 Data 4

8 DATA 3 Data 3

9 DATA 1 Data 1

10 GND Ground

11 RSV Reserved

12 RSV Reserved

13 +5V +5 Volts, 250 mA DC Source

14 RSV Reserved

15 GND Ground

16 TRG OUT Trigger Out

17 TRG IN 0 Trigger In 0

18 DATA 7 Data 7

19 DATA 5 Data 5

20 GND Ground
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3.6  PC Connection
Use the LONGEST (6-foot/2-meter) of the five USB cables provided to 
connect the host computer to the USBTracer Analyzer box.

3.7  Analyzer PC Requirements
Please refer to the Readme.txt file on the installation CD for PC and 
operating system requirements.

3.8  Setting Up the Analyzer
Step 1 Connect the provided AC power cord to the rear of the UPAS and to 

a 100-volt to 240-volt, 50 Hz to 60 Hz, 100 W power outlet.

Note The Analyzer is capable of supporting supply voltages between 
100-volt and 240-volt, 50 Hz or 60 Hz, thus supporting all known 
supply voltages around the world.

Step 2 Turn on the power switch on the rear of the analyzer.

Note At power-on, the analyzer initializes itself in approximately ten 
seconds and performs an exhaustive self-diagnostic that lasts about 
five seconds. The Trigger LED illuminates during the power-on 
testing and turns off when testing is finished. If the diagnostics fail, 
the trigger LED blinks continuously, indicating a hardware failure. 
If this occurs, call LeCroy Customer Support for assistance.

Step 3 Connect the USB cable between the USB port on the back of the 
analyzer and a USB port on the analyzing PC.

The host operating system detects the analyzer and begins to install 
the USB driver.
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3.9  Installing the Analyzer Software on the PC
Once USBTracer has been recognized as a USB device, install the 
USBTracer software on the PC administering the analyzer: 

Step 1 Insert the USBTracer CD into the CD ROM drive of the PC 
that will administer the Analyzer. 

Step 2 Follow Microsoft® Windows® on-screen Plug-and-Play 
instructions for the automatic installation of the USBTracer 
Analyzer as a USB device on your analyzing PC (the required USB 
files are included on the USBTracer CD.

Step 3 Select Install Software from the installation CD and follow 
the on-screen installation instructions.

The USBTracer application installs on the PC hard disk.

Step 4 To start the application, launch the LeCroy USBTracer program 
from the Start Menu: 
Start > Programs > LeCroy > LeCroy USBTracer. 

The USBTracer program opens.
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3.10  USBTracer Program Startup
You can start the USBTracer program from the Desktop or from the 
installed directory. The program always begins with its main screen active: 

The software may be used with or without USBTracer. When used without 
USBTracer, the program functions in a Trace Viewer mode to view, 
analyze, and print captured protocol traffic.

When the program is used with the USBTracer Protocol Analyzer attached 
to the computer, you can set trigger conditions, record, monitor and analyze 
the activity of your USB bus.

3.11  Making a Recording
After installation, the software is configured to make a Snapshot recording 
of USB traffic.

See Section 2.2 "Your First USB Recording" on page 14 to make your first 
recording of this traffic.
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4.  Updates
From time to time as modifications are made to the USBTracer™ Analyzer, 
it is necessary to update the USBTracer for optimal performance. Updates 
can be performed two ways: either automatically or manually. This chapter 
describes both procedures.

4.1  Software, Firmware, and BusEngine Revisions
The Readme.txt file on the first installation disk and in the installed 
directory gives last-minute updates about the current release. Included with 
each release are the most recent downloadable images of the Firmware and 
the BusEngine™. 

Once the Analyzer has completed the self diagnostics and is connected to 
the PC, you can check the latest revision of the software and BusEngine by 
selecting About USBTracer… from the Help menu. 

About USBTracer details revisions of the following software and 
hardware:

• USBTracer Software Version

• USBTracer Firmware Version

• BusEngine Version

• Unit Serial Number

Note When contacting LeCroy for technical support, please have 
available all the revisions reported in the About USBTracer 
window.
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4.2  Software Updates
When a new software release is available, it is posted on the Support page 
of the LeCroy website at www.lecroy.com/support.html.

To update the software: 

Step 1 In the About USBTracer screen, verify which version of 
USBTracer Software you are currently running.

Step 2 Find the latest released software version on the LeCroy website 
under Support.

If you are running the latest version of the software, no 
further action is needed. 

If you are not running the latest version, continue to Step 3.

Step 3 Download the Zip files from the website. 

Step 4 Unzip the files into your choice of directory.

Step 5 Click Start, then Run, and browse to where you unzipped the files.

Step 6 Select the program named Setup and click Open.

Step 7 Click OK to run the Setup and begin the installation.

Step 8 Follow the on-screen instructions to complete the installation.

Step 9 Read the Readme file for important information on changes in the 
release.

4.3  BusEngine and Firmware Updates
BusEngine and Firmware updates often need to be performed when you 
update the USBTracer software. These updates can be performed 
automatically or manually. Both processes are described.

Updating the BusEngine

The BusEngine core is the heart of the USBTracer Analyzer. Using 
state-of-the-art Electronically Programmable Logic Device (EPLD) 
technology, it incorporates both the high speed recording engine and the 
configurable building blocks that implement data/state/error detections, 
triggering, capture filtering, external signal monitoring, and event counting 
and sequencing. Both the BusEngine program and the Firmware that 
manages the internal microcontroller are fully field upgradeable.
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Within a new software release, it may be necessary to update the Analyzer’s 
BusEngine hardware for proper operation. The Readme file lets you know 
if this is necessary. 

Updating the Firmware

Within a new software release, it may also be necessary to update the 
Analyzer’s firmware for proper operation. The Readme file informs you if 
this is necessary. 

Automatic Updates

When the USBTracer software is upgraded, the software may become 
incompatible with the BusEngine and Firmware. If a recording is attempted, 
USBTracer displays an error message and then automatically begins an 
update process for the BusEngine and Firmware.

To perform an automatic BusEngine and Firmware update, follow these 
steps: 

Step 1 If needed, update the USBTracer software using the steps outlined 
in "Software Updates" described above.

Step 1 Turn on the Analyzer.

Step 2 On the Tool Bar, click the button.

Since the BusEngine and/or the Firmware are incompatible with the 
current USBTracer software version, an error message appears 
displaying your current versions and indicating what versions you 
need to install.
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Step 3 Click Yes to close the window closes and open the Analyzer Setup 
window.

Step 4 Click Update BusEngine or Update Firmware.

You can select only one item at this point. If both the BusEngine and 
the Firmware need to be updated, the update completes for the first 
item and then returns to the above screen so the second update can 
be performed. 

If you are running Microsoft® Windows® 98, you get the following 
message when the second update is completed: 
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Step 5 Power cycle USBTracer to complete the update.

If you are running Windows 2000, the analyzer automatically 
reboots and displays the following message. When this message 
appears, click OK. You do not need to power cycle the analyzer. 

Manual Updates to BusEngine and Firmware

You can manually update the USBTracer Firmware and/or BusEngine™ by 
performing the following steps: 

Step 1 Select Analyzer under Setup on the Menu Bar to display the 
Analyzer Setup screen: 
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Step 2 To update the BusEngine, click Update BusEngine on the 
Analyzer Setup screen to display the Select the engine file to 
download window: 

The program displays the correct file (Upas_Usb2_2A_be.rbf) in 
the File name field. This file is used to update the analyzer alone 
(i.e., without a Traffic Generator). The other file 
(Upas_Usb2_2A_1G_be.rbf) should be selected if you upgrading a 
UPAS system with both an analyzer and Traffic Generator.

If you have purchased device emulation, then the needed BusEngine 
file is Upas_usb2_1A_1G-be.rbf.

Note The most current Primary BusEngine file was copied to your 
\LeCroy\USBTracer directory when you installed the program. 

Step 3 Click Open.

Step 4 Power cycle the analyzer.

Re-initialization takes a couple of minutes.
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Manually Updating the Firmware

To update the firmware: 

Step 1 Click Update Firmware on the Analyzer Setup screen to display 
the Select firmware file window: 

The program has already automatically searched for the correct file 
and displays it in the File name field.

Step 2 Click Open.

The Analyzer updates the Firmware.

Step 3 Unplug the USB cable from the back of the Analyzer box and then 
reinsert it so the new Firmware update can take effect.

4.4  Resetting the Analyzer
The Analyzer Setup window contains a reset button at the top of the 
window. Its function is the equivalent of power cycling the Analyzer.
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5.  Software Overview
The USBTracer™ Trace Viewer is an application that may be used with or 
without the Analyzer box. When used without an Analyzer box, the program 
functions in a Trace Viewer mode to view, analyze, and print captured 
protocol traffic from USBTracer Analyzers. The software also allows you 
to view trace files created by the LeCroy Chief™, Advisor™, Detective™, 
and Inspector™. Opening a file created with either of these Analyzers 
displays a screen asking if you want to convert the old file to the new format 
under the name convert.usb.

When the program is used with the USBTracer Analyzer attached to the 
computer, you can monitor and analyze the activity of your USB branch 
from either of the USB ports on the front of the Analyzer.

5.1  Starting the USBTracer Program
To start the USBTracer Program:

Step 1 Select Start > Programs > LeCroy > LeCroy USBTracer.

5.2  Tooltips
 Tooltips provide useful information about cells in the 
trace and buttons in the application. To display a tooltip, 
position the mouse pointer over an item. 
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5.3  The Main Display Windows
While some of the analyzer’s Main Display window options are familiar, 
many contain options specific to the analyzer program. 

Menu Function

File

New .utg file. Creates a new, empty traffic generation file. Available only if a 
trace file (.usb) is open. To edit a .utg file, click the Edit as Text 
button in the toolbar.

Open Opens a file.

Close Closes the current file.

Save As Saves all or a range of packets from the current file.

Print Prints part or all of the current traffic data file.

Print Preview Produces an on-screen preview before printing.

Print Setup Sets the options for the current or new printer.

Edit as Text Opens the Script Editor. Available only when a traffic generation 
file (.utg) is open.

Edit Comment Creates or edits the Trace file comment field.

Check Syntax of .utg file Reads open .utg file and checks syntax for errors. Available only 
when a traffic generation file (.utg) is open.

Export>>

Packets to Text (Packet 
View Format)

Packets to .CSV 
(Comma Separated 
Values for Excel, etc.) 
Format)

Packets to Host Traffic 
Generator Text File 
(.utg)

Packets to Device 
Emulation Traffic 
Generation Text File 
(.utg)

Data

Saves all or part of a trace to a text file or generator file.

Saves trace as text file in Packet View Format.

Saves trace as a comma-separated-values text file for use with 
Microsoft® Excel.

Saves trace as script file that can be used by a Generator to generate 
a trace.

Exports packets to Device Emulation files. This option does not 
export transactions.

Exports Transfer data as text or binary file.

Merge Trace Files Merges two simultaneously recorded files into a single file. (This 
command does not work if the files were recorded at different 
times).

Import Import data from .vcd file

Compare Endpoint Data Allows you to select two endpoints of different directions with the 
same address and verify that the data OUT/IN is identical to the data 
IN/OUT from the other endpoint. Used when running echo-types of 
tests for data integrity. Available only when a trace file (.usb) is 
open. 

Exit Exits the USBTracer program.
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Setup

Display Options Provides display options such as color, formats, and filters.

Recording Options Provides setup options for recording, triggering events and filtering.

Setup Analyzer Allows you to update the BusEngine™ and Firmware.

Record

Start Causes the Analyzer to begin recording USB activity.

Stop Causes the Analyzer to stop recording.

Upload Again Allows you to upload a different portion of the captured trace if the 
previous upload was only partially uploaded. 

Generate

Start Starts traffic generation. Once traffic generation has begun, the Start 
command becomes Stop and lets you stop traffic generation.

IntelliFrame Generation 
Mode

Sets the mode of generation to IntelliFrame. Use before Start.

Bitstream Generation 
Mode

Sets the mode of generation to bitstream. Use before Start.

Repeat Mode Allows you to repeat once, a specified number of times, or an 
infinite number of times using the Generation Repeat Mode 
window.

Report

File Information Displays information about the recording such as the number of 
packets and triggering setup.

Error Summary Summarizes the errors throughout the recording. Allows for fast 
navigation to packet with errors.

Timing Calculations Calculates timing between two packets and bus utilization.

Traffic Summary Summarizes the numbers and types of errors, packets, transactions, 
split transactions, and transfers that occurred in the open trace.

Bus Utilization Displays graphs of packet length, bus usage, and bus usage by 
device. 

Search

Go to Trigger Positions the display to show the first packet that follows the trigger 
event.

Go to Packet/
Transaction/Transfer

Positions the display to the packet/transaction/transfer number 
selected in the Go to Packet/Transaction/Transfer menu.

Go to Marker » Positions the display to the selected marked packet.

Go to » Positions the display to the selected event, condition, value, or type.

Find Allows complex searches on multiple criteria.

Find Next Repeats the previous Find operation.

Search Direction Allows the search direction to be changed from Forward to 
Backward or vice versa. 

Menu Function
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View

Toolbars Displays list of available toolbars.

Status Bar Switches display of the Status Bar on or off.

Real-time Statistics Allows you to view traffic statistics as they occur.

Zoom In Increases the size of the displayed elements.

Zoom Out Decreases the size of the displayed elements.

Wrap Wraps displayed packets within the window.

Hide SOF’s Hides Start of Frames.

Hide NAK’s Hides NAK’ed Transactions.

Hide Devices Hides packets belonging to specified devices by address and 
endpoint.

Hide Chirps Hide the Chirp-K and Chirp-J Bus conditions. These are recorded 
only in USBTracer. 

Apply Decoding Scripts Decoding scripts set the values of the display and recording options 
for optimum views of trace information from specific vendors or 
classes of data. This menu option allows you to select the vendor or 
class of data for the request recipients and endpoints listed in the 
Request Recipients and Endpoints menu. You can keep the settings 
across recordings.

Packet Level Displays Packets.

Transaction Level Displays Transactions.

Split Transaction Level Displays Split Transactions.

Transfer Level Displays Transfers.

Refresh Decoding Force the software to re-decode transactions and transfers. Useful if 
you have applied a decoding mapping which helps fully decode a 
sequence of transfers, as is the case with Mass Storage decoding.

Window

New Window Switches display of the Tool Bar on or off.

Cascade Displays all open windows in an overlapping arrangement.

Tile Horizontal Displays all open windows in a above-below arrangement.

Tile Vertical Displays all open windows in a side-by-side arrangement.

Arrange Icons Arranges minimized windows at the bottom of the display.

Windows ... Displays a list of open windows.

Help

Help Displays online help. You can also select F1.

Help Topics Displays online help.

Update License Opens a dialog box for updating your LeCroy license. 

Display License 
Information

Displays information related to licensing.

About USB USBTracer Displays version information about USB USBTracer.

Menu Function



 39

  USBTracer/Trainer User ManualLeCroy SW Version 2.20

5.4  View Options
You can hide, display or reset toolbars by selecting 
View > Tool bars from the menu bar.

Resetting the Toolbar

From time to time (such as following a software 
upgrade), it is possible for the buttons on the toolbar 
to not match their intended function. You can reset 
the toolbar by performing the following steps:

Step 1 Select View > Tool bars from the menu bar.

Step 2 Select Customize from the submenu to display the Customize 
dialog box. 
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Step 3 Select the Toolbars tab to display the Toolbars page of the 
Customize dialog box. 

Step 4 Click the Reset All button.

The toolbar resets to the factory defaults.

Tool Bar

The Tool Bar provides quick and convenient access to the most popular 
USBTracer program functions. Tool tips briefly describe the functionality 
of each icon and menu item as the mouse arrow is moved over the icon/item. 

Open file Find Next

Save As File Information Report

Preview Error Report

Edit as Text Timing and Bus Usage Calculations

Print… Traffic Summary

Setup Record Options Bus Utilization



 41

  USBTracer/Trainer User ManualLeCroy SW Version 2.20

5.5  Status Bar
The Status bar is located at the bottom of the main display window. 
Depending on the current activity, the bar can be divided into as many as 
four segments.

Setup Display Options Open the Navigator bar

Start Recording Display Packets

Stop Recording Display Transactions

Display Realtime Statistics. Display Split Transactions

Zoom In Display Transfers

Zoom Out Display Host Wire Adapter Segments

Wrap Display Host Wire Adapter Transfers

Hide SOFs Display Device Wire Adapter Segments

Hide NAK’ed transactions. Display Device Wire Adapter Transfer

Hide Devices

Start or Stop Traffic Generation (available if 
you have the USBTrainer modul)e.

Hide Chirps Bitstream and Intelliframe modes

Assign High Level Decodes. Repeat Upload

 Find

Repeat Mode. This button becomes active 
when a traffic generation file (*.utg) is open.
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Recording Progress

When you begin recording, the left-most segment of the Status Bar displays 
a Recording Progress Indicator: 

As recording progresses, the Progress Indicator changes to reflect the 
recording progress graphically:

• In the Progress Indicator, a black vertical line illustrates the 
location of the Trigger Position you selected in Recording Options. 

— Pre-Trigger progress is displayed in the field to the left of the 
Trigger Position in the before-Trigger color specified in the 
Display Options. 

— When the Trigger Position is reached, the progress indicator 
wiggles as it waits for the trigger. 

— After the trigger occurs, the field to the right of the Trigger 
Position fills in the after-Trigger color specified in the Display 
Options. 

— When recording is complete, the upper half of the progress 
indicator fills in white, indicating the progress of the data 
upload to the host computer.

You should be aware of two exceptional conditions: 

• If a Trigger Event occurs during the before-Trigger recording, the 
before-Trigger color changes to the after-Trigger color to indicate 
that not all the expected data was recorded pre-Trigger. 

• When you click Stop before or after a Trigger Event, the Progress 
Bar adjusts accordingly to begin uploading the most recently 
recorded data.

The Progress Bar fills with color in proportion to the specified size and 
actual rate at which the hardware is writing and reading the recording 
memory. However, the Progress Indicator is normalized to fill the space 
within the Status Bar.
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Recording Status

During recording, the current Recording Status is displayed in the next 
segment. When you activate the Record function, this segment flashes one 
of the following messages (depending on the selected Recording Options):

• Trigger?

• Triggered!

• Uploading

After recording stops, 

• The flashing message changes to Uploading data–x% done (x% 
indicates the percentage completion of the data uploading process). 

• The traffic data is copied to disk (overwriting any previous version 
of this file) using the default file name data.usb. If two channels of 
traffic are recorded, USBTracer creates two files:data_0.usb and 
data_1.usb. You can also create a file name of your choice by 
specifying one in the Recording Options dialog box.

To abort the upload process: 

• Press Esc on your keyboard
OR

• Again click in the Tool Bar. 

You are asked if you want to keep or discard the partially uploaded data.

Note: While uploading is in progress, clicking the stop button again brings 
up a dialog opens a dialog that allows you to do a partial upload, flush the 
current file, keep what has uploaded at this point, and to continue uploading.
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The Partial Upload button is enabled when you have partially uploaded data. 
When you click Partial Upload, a dialog box appears that gives you options 
on what portion of data you want to upload again. 

When the data is saved, the Recorded Data file appears in the main display 
window and the Recording Status window is cleared. 

• If the recording resulted from a Trigger Event, the first packet 
following the Trigger (or the packet that caused the Trigger) is 
initially positioned second from the top of the display.

• If the recording did not result from a Trigger Event, the display 
begins with the first packet in the traffic file.

Recording Activity

During recording, the fourth segment from the left of the Status Bar displays 
Recording activity as a series of vertical bars. 

The more vertical bars that are displayed, the greater the amount of activity 
being recorded. If there are no vertical bars, there is no recorded activity. 

During uploading, the percent of the completed upload is displayed.

Note If packets are filtered from the recording or data are truncated, 
the recording activity is reduced.
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Search Status

The rightmost segment displays the current search direction: Fwd (forward) 
or Bwd (backward). Change the search direction from the Search Menu or 
double-click in the Search Status segment. 

5.6  Navigation Tools
You can zoom in and out, and wrap packets/transactions/transfers to fit 
within the screen using the following buttons:

Zoom In

Zoom In increases the size of the displayed elements, allowing fewer (but 
larger) packet fields per screen. 

• Click on the Tool Bar.

Zoom Out

Zoom Out decreases the size of the displayed elements, allowing more (but 
smaller) packet fields per screen. 

• Click on the Tool Bar.

Wrap

Select Wrap to adjust the Trace View so that packets fit onto one line. If a 
packet is longer than the size of the window, the horizontal scroll bar can be 
used to see the hidden part of the packet.

• Click on the Tool Bar or select Wrap under View on the Menu 
Bar.
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5.7  USBTracer Analyzer Keyboard Shortcuts
Several frequently-used operations are bound to keyboard shortcuts. 

Table 1: Keyboard Shortcuts
Operation Key Combination

Trace Navigation

Find Next F3

Search Backwards Ctrl+B

Search Forwards Ctrl+F

Jump to First Packet Ctrl+Home

Jump to Last Packet Ctrl+End

Go to Any Error Shift+E

Go to Channel 0 Ctrl+Shift+0

Go to Channel 1 Ctrl+Shift+1

PID

Go to ACK Shift+A

Go to DATA0 Shift+0

Go to DATA1 Shift+1

Go to DATA2 Shift+2

Go to DATAx Shift+D

Go to IN Shift+I

Go to MDATA Shift+M

Go to NAK Shift+N

Go to NYET Shift+Y

Go to OUT Shift+O

Go to PING Shift+G

Go to PRE/ERR Shift+P

Go to SETUP Shift+S

Go to SOF Shift+F

Go to SPLIT Shift+X

Go to STALL Shift+L
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Bus Conditions

Go to Reset Shift+T

Go to Resume Shift+6

Go to SE0 Shift+Z

Go to SE1 Shift+7

Go to Keep-Alive Shift+5

Go to Suspend Shift+U

Go to Chirp Shift+C

Go to Full Speed J Shift+J

Go to Full Speed K Shift+K

OTG

Go to SRP Ctrl+Q

Go to HNP Shift+H

Go to VBus Voltage Change Shift+V

Go to OTG Host A Ctrl+Shift+A

Go to OTG Host B Ctrl+Shift+B

Misc.

Marker Menu Ctrl+M

Open File Ctrl+O

Print… Ctrl+P

Record Ctrl+R

Stop Recording Ctrl+T

Open Display Options dialog Ctrl+Shift+D

Open Recording Options dialog Ctrl+Shift+R

Hide SOFs Ctrl+Shift+S

Hide NAKs Ctrl+Shift+N

Hide Chirps Ctrl+Shift+C

Apply Decoding Scripts Ctrl+Shift+Y
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6.  Recording Options
Use Recording Options to create and change various features that control 
the way information is recorded by the USBTracer Analyzer. 

To open the Recording Options dialog box: 

• Select Recording Options under Setup on the Menu Bar.
OR

• Click on the Tool Bar.

You see the Recording Options dialog box: 

The Recording Options window always opens with the General tab 
showing. 



50

  USBTracer/Trainer User ManualLeCroy SW Version 2.20

6.1  General Recording Options
The General Recording Options allow you to select or adjust the recording 
type, the buffer size, the amount of post-trigger recording, and the trace 
filename and path.

Recording Type

The Recording Type box presents three options that allow 
you to set how USBTracer™ begins and ends a recording. 
The options are: Snapshot, Manual Trigger, and Event 
Trigger.

Snapshot
A Snapshot is a fixed-length recording. The size of this recording is set by

 the Buffer Size box. Recording begins when is clicked and ends

 when either the selected buffer size is filled or the button is pressed. 

Manual Trigger
A Manual Trigger is a recording whose trigger point is caused by pressing 
the trigger button on the front panel.

Recording begins when you click on the Tool Bar. Recording 
continues in a circular manner within the limits set by the buffer size.

Recording ends when is clicked on the Tool Bar or after post-trigger 
memory has been filled following depression of the trigger button on the 
front panel.

Event Trigger
Recording begins when you click on the Tool Bar.

Recording continues in a circular manner within the limits set by the buffer 
size until an event is detected that meets the Trigger conditions specified in 
the Triggering Options and the defined amount of data has been recorded 
after the Trigger Event.
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Options

• Truncate Data Fields: Allows data fields to be truncated during 
recording in order to save Analyzer memory and allow recording of 
more packets. Enter a minimum data length value in the Bytes box. 
USBTracer truncates the data to the stated value or slightly larger.

Note Truncation of data may cause incorrect transaction or transfer 
decoding. 

• Beep When Trigger Occurs: The computer connected to the 
USBTracer beeps three times when a Trigger condition is first 
detected.

• Auto-Merge 2 Channel Trace Files: Causes USBTracer to merge 
traffic of the two recording channels into a file called 
data_merged.usb (or whatever name you wish to give it). 
USBTracer also makes two other files during this recording: 
data_0.usb and data_1.usb (or whatever names you choose to give 
them). If unchecked, USBTracer creates only two files: one for 
Classic-Speed traffic and another for Hi-Speed traffic.

• Save External Interface Signals: Causes USBTracer to save 
signals from a Break-out board (pins Data7 - Data0) as fields in the 
trace. 

• Trigger/Filter Channel: Presents a choice of Channel 0 or 
Channel 1. The selected choice tells USBTracer what channel it 
should use to perform its triggers/filters. If you want to set 
triggers/filters on both channels, then you must select a channel, 
assign trigger/filter events and actions, then select the other channel 
and assign trigger filter events and actions to it. In other words, you 
must set your events and actions twice - once for each channel. The 
channel you are currently applying the triggers/filters to is shown in 
the Dialog Title Bar.

Buffer Size

You can adjust the size of the recording buffer from 0.4 megabytes to 512 
megabytes. 

The Recording type option determines how this buffer is used. Although 
there are 512 megabytes of physical memory in the Analyzer, the efficiency 
of the recording is about a 2:1 ratio of physical memory to actual USB 
traffic. Shorter USB packets yield a slightly less efficient recording. The 
non-traffic portion of physical memory is utilized for control and timing 
information.
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Note The scale is not linear and affords more granularity in the smaller 
buffer sizes. 

Trigger Position

You can adjust the amount of recording to be done post-Trigger or select 
where you want the Trigger located within the defined buffer. You can 
adjust the Triggering Position between 1 and 99% post-Trigger. Trigger 
Position is available only when Manual Trigger or Event Trigger is 
selected as Recording type.

As an example, if the buffer size is set to 16MB, then for the following 
Trigger Position settings, the amount of pre- and post-Trigger data is

• 95% post-triggering: 0.8MB pre-trigger, 15.2MB post-trigger

• 75% post-triggering: 4MB pre-trigger, 12MB post-trigger

• 50% post-triggering: 8MB pre-trigger, 8MB post-trigger 

• 25% post-triggering: 12MB pre-trigger, 4MB post-trigger

• 5% post-triggering: 15.2MB pre-trigger, 0.8MB post-trigger

Note When a Trigger occurs, recording continues until the 
post-Trigger amount of the buffer is filled or when Stop is 
selected.

Options Name

The Options Name is a descriptive label of the current Recording Options 
settings. Options Names are associated with files that have a .rec suffix. 

The default option name is default. Default preserves the current Recording 
Options settings.

The purpose of the Options Name box is to give you a place to preserve 
different Recording Options that you use on a recurrent basis. For example, 
if you use two or three different Recording Options configurations, you can 
save these configurations and load them the next time they are needed.

Because Options Names are descriptive labels and not file names, you can 
enter in any text you like into the box. Your labels can be very descriptive 
such as "Trigger on High Speed traffic when CRC errors occur." 

To create a new Recording Options name: 

Step 1 Enter a comment for the new file in the Options Name field.

Step 2 Click Save to display the Save As window.
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Step 3 Specify a filename (*.rec)

Step 4 Click Save.

To load a Recording Options name:

Step 1 Click Load to display the Open window.

Step 2 From the list of .rec files, select the one that represents your Options 
Name.

The options settings for that name then display.

Trace File Name & Path

Trace File Name & Path opens a Save As dialog box for saving your trace 
file. The default recording file name is data.usb for Low, Full, and High 
Speed recordings. If you are recording on both channels, then USBTracer 
creates two files: data_0.usb for Channel 0, and data_1.usb for Channel 1.

• Click Trace File Name & Path.

You see a Save As… window in which to enter the recording file name 
*.usb for all subsequent recordings.
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6.2  Recording Options - Misc
The Misc page presents options for setting:

• Analyzer speed

• Device emulation

• OTG

• Clocking Overrides

• Traffic Generation



 55

  USBTracer/Trainer User ManualLeCroy SW Version 2.20

Analyzer Speed

This option sets the speed of the traffic recorded by the analyzer. Normally, 
the default setting "Auto-detect" is used. This setting tells the analyzer to 
discover what speed traffic is running and to label packets accordingly. If 
you are having problems with your recordings, you might try setting the 
traffic speed to one of the fixed values -- Low, Full, and Hi speed. These 
settings are used when you want to manually set the traffic speed. 

In some rare cases, auto-detection circuitry causes Full Speed devices to fail 
to enumerate on plug-in. Changing the analyzer speed to Full Speed can 
sometimes solve this problem.

Setting the speed to one of the fixed values is sometimes useful for 
debugging purposes. For example, if a device that is producing numerous 
errors at a particular speed, you may wish to set the recording to that speed 
in order to ensure that the analyzer does not misread the error packets and 
label them the wrong speed. While it is unlikely that the analyzer will 
mislabel packets in this way, manually setting the recording speed 
guarantees that the analyzer always records packets at the correct speed.

You can set the speed for one or both channels.

Notes on Hi Speed Recordings
Erroneous chirp blocks can be recorded on an idle bus when the Device has 
its FS terminations on while the Host has HS terminations connected. This 
causes a small differential voltage (a.k.a "tiny-J") on the USB bus that 
causes false Chirp detection. 

This condition occurs during speed negotiation: 

• On a HS bus, the condition is momentary just before the device 
chirps.

• On a CS bus, the condition occurs both before and after the device 
chirp (until the end of Reset). The user is discouraged from using 
"Speed=HIGH" to record signals on a classic speed bus.

• The analyzer stops recording anything for 2.5 milliseconds 
following a FS_K state (which is at least 2 microseconds long). 
This is to avoid presenting "garbage" which is a by-product of the 
high-speed probe settling down.
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Generator/Analyzer Clocking Overrides

Generator/Analyzer Clocking Overrides allows changes to be made to the 
analyzer/generator clocking. Select Slow Clock, then enter a value in the 
box on the right. The value that is entered tells the analyzer how much to 
divide the base clock by. For example, entering a 4 causes Full Speed traffic 
to be generated at a 3-megabit rate as opposed to the standard 12-megabit 
rate.

USB On-The-Go

USB On-The-Go option sets analyzer to record the USB On-The-Go 
traffic. This protocol lets you run two devices, specify one of them as the 
host, one of them as the device, and to assign each device a name.

USBTrainer Generator-related Parameters

Default to IntelliFrame Mode sets IntelliFrame default to "ON."

In IntelliFrame mode, the generator can wait for Device responses to 
complete before it continues generating more host packets. For example, 
after issuing an IN, the generator looks for the DATAx packet issued by the 
device to finish, and then issues an ACK. This way, the data length can vary 
and does not need to be pre-calculated. Also, using the "idle=TO_EOF" 
statement allows the generator to calculate where the end of the frame 
occurs, so that a subsequent "frame=AUTO" statement creates a Start of 
Frame at the correct time. Moreover, the Generator can be made to retry 
transactions that are NAKed automatically, and to use the PING protocol 
where appropriate. Retries can be made to occur within the same frame or 
in the next frame. For further information on the flexible behavior that can 
be instituted during the generation, see the syntax descriptions for the 
generation files. An additional advantage of the IntelliFrame mode is that it 
creates an image in the Generator’s memory that is MUCH smaller than that 
of the Bitstream mode, so it downloads much faster. 

Disable Generator Memory [allow 512 MB traces with a USBTrainer 
plug-in] allows you to specify 512 MB traces on systems with a 
USBTrainer plug-in.

Device Emulation Mode [tracing limited to Channel 0 only]: Allows 
changes to the Resume time and the device address.

Device Resumes: If checked, the Device is responsible for issuing the 
Resume signal after waiting the specified amount of time following a 
suspend. If the Device Resumes option is not selected, the device waits 
indefinitely for the Host to resume signalling.
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Delay Time: The time (in milliseconds) to wait after suspend before 
initiating a Resume.

Resume Time: The Resume Time (in milliseconds) is used to configure 
how long a device should issue a Resume (K) signal once the delay time has 
occurred. Be careful to make this shorter than what the host does once it 
recognizes the Resume signal as a Remote Wakeup. 

If the Device Resumes option is not selected, the device waits indefinitely 
for the Host to resume signalling.

• Use Address in .utg file: Causes the analyzer to use whatever 
Device address has been specified in the.utg file.

• Emulate Device’s Hex Address: Allows the user to specify a 
different address than the one specified in the .utg file. This option 
is useful in cases where the host does not use the same address each 
time.

• Chirp Reset Length: Allows the Reset Length for Chirps to be 
edited. The default is 50 milliseconds. (Host generation only).
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6.3  Slow Clock Selection
You can use the slow clock selection to slow down the base clock during 
generation. This also changes the Analyzer’s clock base to match.

Step 1 In the Misc tab, make sure you are out of Auto-Detect mode. 

Step 2 Select the Slow Clock checkbox. 

Step 3 In the Divide By field, enter a value. 

Step 4 Click OK.

Using this feature for Hi-Speed requires a License Key from LeCroy. 
Contact your LeCroy representative. 
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6.4  Events Recording Options
The Event triggering and filtering options allow you to set specific 
parameters for each Event Group. When an Event Group is selected, a field 
appears that allows you to select specific conditions within the 
corresponding Event Group. As details are selected, other Event Group 
details may become "grayed out" because of limited hardware resources in 
the Analyzer. Information about the resources available is displayed below 
the Event Group details. When a detail is grayed out, it is inactive and 
cannot be selected. If an Event Group remains inactive, the current version 
of the application or BusEngine™ does not support it.

Click the Events tab on the Recording Options screen to display the Event 
Groups dialog box: 
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Packet Identifiers

Select Packet Identifiers under Event Groups. You see the Packet 
Identifiers window: 

The Packet Identifier (PID) field lists the available packet types. Select up 
to three packet types to use as a Recording Trigger. 

Token Patterns

Select Token Patterns under Event Groups. You see the Token Patterns 
window: 

Specify up to three combinations of Address/Endpoint with any of the token 
PIDs. They can be triggered on or filtered in/out. 
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Frame Patterns

Select Frame Patterns under Event Groups. You see the Frame Patterns 
window: 

Identify frame patterns you want either to filter out of a Trace View or to use 
as a Trigger. You can select either All Start of Frame packets (SOF) to be 
filtered out or specify the Frame Number of a frame to trigger on.

Device Requests

Select Device Requests under Event Groups. You see the Device 
Requests window: 
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You can select one or two Device Requests for triggering or filtering.

Data Pattern

Select Data Pattern under Event Groups. You see the Data Pattern 
window: 

Enter a Data Pattern to be triggered upon or click Edit to open a pattern 
editor and enter data on a bit-by-bit basis.
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Step 1 Press the Edit button.

You see a Bit-by-Bit window:

Step 2 Click your mouse on the bits within each byte that you wish to edit 
and enter in the appropriate text. 

The Mask and Match fields change to reflect your changes.
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Bus Conditions

Select Bus Conditions under Event Groups. You see the Bus Conditions 
window: 

Use any combination of the listed errors as a Trigger.

Errors

Select Errors under Event Groups. You see the Errors window: 
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Use any combination of the listed errors as a Trigger.

• Bit Stuffing, Frame-Length, CRC, Pid, EOP, Short Byte 
checkboxes: Select one or more of these errors to set these as the 
basis for triggering or filtering. A Short Byte is a condition where 
EOP begins on a non-byte boundary.

• Time-out Violation - Select this checkbox and then enter in the 
Turn-around time in the text box. This value tells the analyzer how 
much time should elapse before triggering/filtering. Clocks are 60 
MHz (with a resolution of 16.66 ns).

• Excessive Empty Frame Detection - Select this option and enter 
the empty frame count in the text box. This value tells the analyzer 
how many frames should elapse before triggering/filtering. 

• Babble Start Violation - Select this checkbox to trigger or filter 
whenever the start of a packet occurs too late in a Frame.

• Babble End Violation (or LOA) - Select this to trigger/filter when 
the end of a packet occurs too late in a Frame. Enter a value in the 
EOF offset box from 1 to 65,535 clocks to indicate the size of the 
offset from start of previous SOF.

• Bad Data Toggle - Select this checkbox to trigger or filter 
whenever a Data0, Data1, Data2 toggle violation occurs. 

— Select IN or OUT if you only want triggering/filtering to 
occur only on IN or OUT transactions. 

— Check Incl Reset if you want the first toggle value after a 
reset to be considered "good" regardless of the value prior to 
that reset. If Unchecked, the toggle state is assumed to be 
preserved through the reset. 

— Select Addr and/or Endp to select Token Addresses and/or 
Endpoints.
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External Input Signals

Select External Input Signals under Event Groups. You see the External 
Input Signals window: 

This window has three checkboxes: Input 0 (TRIG IN 0), Input 1 
(TRIGGER IN 1), and Input 2 (Ext. 1 or Ext. IN). Use any combination 
of the inputs as a Trigger.

Transactions

Select Transactions under Event Groups. You see the Transactions 
window: 

Use any combination of the listed errors as a Trigger.
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Data Length

Select Data Length under Event Groups. You see the Data Length 
window: 

To trigger on data length, enter a value between 0 and 1024 in the box 
marked Data Length. 
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Splits

Select Splits under Event Groups. You see the following window.

To trigger on splits, select a split type, and endpoint type, and an address. 
You can also select FS Isoch Out when you select the Isoch endpoint type. 

Extern Data7 - Data0 In

Select Extern Data7 - Data0 In under Event Groups.

To trigger on Extern Data 7 - Data0 In, enter values in the Match and Mask 
fields.
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6.5  Actions Recording Options
The Actions screen serves as a means of setting Triggers, Filters (In or 
Out), and Counts for the events selected in the Events window.

Actions Window Layout 

The Actions window divides into three sections: left, center, and right.

The left section displays buttons for the events selected in the Events 
window. Events buttons tell USBTracer what it should look for during a 
recording. The number of Event buttons displayed depends on the number 
of Events selected in the Events window. If no Events were selected, no 
Event buttons are displayed.

The right side of the window displays a pair of counters called Count1 and 
Count2. Counters provide a way for setting triggers based on a passage of 
a certain number of events. When an event is linked to a counter, the counter 
appears below the event on the left side of the screen.

The right section displays three Action buttons: Trigger, Filter Out, and 
Restart. Action buttons controls USBTracer’s response to Event 
conditions. For example, if an Error button is linked to a Trigger button, the 
Action button tells USBTracer to trigger when the error condition occurs.

The lines that join the different buttons indicate the links between Actions 
and Events. 
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6.6  Connecting Events to Actions
To create or edit links between Event buttons, Counters, and Action buttons, 
you click an Event button and then click a Counter or Action. By clicking 
an Event, an arrow connects the Event button to the cursor. When you click 
a Counter or Action button, the arrow becomes anchored to the selected 
button.

To make an association: 

Step 1 Select one or more Events from the Events window.

Step 2 Open the Actions window.

Step 3 Click the left mouse button on an Event button such as Errors.

The elastic arrow appears.

Step 4 Point your mouse at the desired Action 
button.

The elastic arrow moves with your mouse 
pointer.

Step 5 With the pointer over an Actions button, click again the left mouse 
button again.

The arrow is anchored to the Action button. replaced with a black 
line connecting the Event button to the Action button.

6.7  Connecting Counters to Events
The right side of the Actions window contains two Counter 
buttons marked Count1 and Count2. These counters provide 
a way of triggering after a number of events have passed, 
such as "Trigger after the 20th IN packet." 
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When an event is linked to a counter, the counter appears under that event 
on the left side of the Actions window. Counters have blue dots in their top 
left corner that provide access to pop-up menus. The menus provide the 
means of setting the counter value. The counter can be set between 1 and 
65,535. 

To connect an event to a counter, 

Step 1 Open the Event window and select an Event.

An Event button appears in the Actions window. 

Step 2 Open the Actions window.

The window displays an Event button that is connected to the 
Trigger button on the right via a line.

Step 3 Click the Event button. 

An arrow connects the Event button to the mouse pointer. 

Step 4 Click one of the two counters.

The Event automatically connects to the Counter button and then 
connects to the Trigger button. 

Step 5 Click the blue dot in top left corner of 
your selected counter.

A pop-up menu opens to allow you to 
configure the counter.
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Step 6 Choose Change Counter Value to open the Input Counter Value 
dialog box.

Step 7 Set the counter to a value of your 
choice, then click OK.

The Input Counter Value dialog 
box closes, and the Counter button 
displays your selection.

Setting Multiple Conditions with Counters
You can create multiple event conditions by linking two counters to two or 
more events.

Linking Two Events to Two or More Counters - If an Event is linked to 
Count1 and a second event is linked to Count2, it creates an "or" statement. 
This statement reads "Trigger when Count1 OR Count2 has reached their 
specified values."

This example reads "Trigger when Count1 has counted 9 Out 
packets or Count2 has counted 9 In packets."
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6.8  Using Action Buttons
The right section of the Actions window displays three 
Action buttons labeled Trigger, Filter Out/In, and Restart. 

Trigger

The Trigger button enables event triggering. 

Restart

Restart causes counters to restart counting when a certain event occurs. 
When Restart is used, the screen has at least two links: one between an 
Event and the Restart button, and a second between an Event, Counter and 
an Action button.

The screenshot below gives an example. The screen below reads "Look for 
IN and Out packets. When 10 OUT packets, trigger. However, if an IN 
packet occurs during the count, restart the count."

Filter Out/In

The Filter In/Out button causes events to be filtered in or out of the 
recording. Filter Out/In toggles between: 

• Filter In records ONLY those packets related to the specified 
event.

• Filter Out records all packets EXCEPT those related to the 
specified event.
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Note Only events from the Token, Frame Event, Device Request, and 
Transaction Groups can be used to filter a recording.

To filter in or out Token, Frame Event, Device Request, and/or Transaction 
Group events from a recording: 

Step 1 Click the blue dot on Filter Out. (Note: the button 
may say Filter In depending on the last action 
specified.)

You see the Filter Polarity menu:

Use this menu to toggle the selection between Filter Out and Filter 
In.

Step 2 Select Filter In. 

The button changes to read Filter In.

6.9  Other Actions: External Output Signals
Most Event buttons can be configured to trigger external output signals.

If a blue dot is present in the Event button, it means that a menu is present 
with three options for configuring external output signalling:

• Enable External Trigger Output

• Enable External Trigger Output only

• External Trigger Form

If you choose to enable External Output signalling, a small blue 
arrow projects from the Event button. This arrow is a reminder that 
External Signals have been set.

To enable or disable external trigger output: 

Step 1 Click the blue dot on an 
Event button.

A menu similar to this one 
opens. Your menu may 
say "Disable" instead of 
"Enable."
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Step 2 Select Enable External Trigger Output (or Disable External 
Trigger Output if that is the choice presented.)

If you have chosen Enable External Trigger 
Output, a small arrow appears on the right side of 
the button. This arrow indicates that a condition has been set for 
creating an external output signal. Choosing Disable External 
Trigger causes the arrow to disappear.

Enabling High Pulse, Low Pulse or Pulse Toggle Signal Outputs
If you chose External Trigger Output in the previous steps, then an 
additional choice appears in the Blue Dot Menu called Enable External 
Trigger. This option lets you control the output signal.

Step 1 Click the blue dot on an event button that has a small arrow attached 
to it like the one shown above.

A Blue Dot Menu opens. External Trigger Form should be an 
option. If it is not, choose Enable External Trigger and then reopen 
the menu.

Step 2 Choose External Trigger Form to display a menu with Pulse Low, 
Pulse High, and Toggle. 

Step 3 Choose an option not currently selected.

The menu closes.

Step 4 Reopen the menu.

Note that your new selection is now checked.
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6.10  Saving Recording Options
To complete your Recording Options settings, use the features at the bottom 
of the Recording Options screen. These features remain the same no matter 
which of the three Recording Options screens you are working in.

• Click Save to save the currently specified Recording Options for 
use in future recording sessions. Any file name can be specified, 
though use of the .rec is recommended; if no extension is specified, 
.rec is added by default.

• Click Load to load a previously saved *.rec file, thus restoring a 
previous set of Recording Options.

• The Save as Default function is equivalent to the Save function, 
specifying the file name default.rec. Whenever you start up the 
Analyzer, it automatically loads the default.rec file if one exists.

• Click OK to apply any changes and close this dialog box.

• Click Cancel to cancel any immediate changes you have made and 
exit the Recording Options menu.

6.11  Recording Bus Data
To start recording USB traffic once the appropriate Recording Options have 
been set perform the following steps. Note: If you have inserted any event 
triggers, be sure to select Event Trigger under the General tab in the 
Recording Options dialog box. 

Step 1 Select Start under Record on the Menu Bar

OR

Click on the Tool Bar.

Your recording session can continue until it has finished naturally,

or you may need to stop manually by clicking on the Tool Bar, 
depending on how you set the Recording Options.

To manually stop recording: 

Step 2 Select Stop under Record on the Menu Bar

OR

Click on the Tool Bar.

Click again during the uploading to upload only a portion of the 
recorded memory. 
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Note The manual Stop Recording feature is primarily of use when 
recording low-speed traffic, which can take a long time to fill the 
recording buffer.

When the recording session is finished, the bus traffic is saved to the hard 
drive as a file named data.usb or whatever name you assign as the default 
filename. 

To save a current recording for future reference: 

Step 3 Select Save As under File on the Menu Bar.

OR

Click on the Tool Bar.

You see the standard Save As screen.

Step 4 Give the recording a unique name and save it to the appropriate 
directory.

6.12  Merging Trace Files
It is possible to merge a Classic-Speed trace file with a Hi-Speed trace file 
using the Merge Trace File command under the File menu. This option only 
works with files that were created simultaneously through a single recording 
session. If the files were recorded during separate recording sessions, 
USBTracer generates an error message and prevents the merge from 
completing.

Note USBTracer is capable of merging High Speed and Classic 
Speeds traffic into a single merged file if the Auto-Merge 2 
Channel Trace Files option is checked in the Recording 
Options dialog box. See page 51 for details.
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To merge two trace files: 

Step 1 Select File > Merge Trace Files to display a dialog box asking for 
the first source file.

Note The Merge Trace Files command can be run with or without a 
trace file open on the screen. The merge process ignores the open 
file.

Step 2 Select the first trace file to be merged, then click Save.

Note It does not matter which of the two trace files is first selected so 
long as both were recorded in the same session.

Step 3 Select the second trace file to be merged, then click Save.

Confirm your choices.
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Step 4 Click Yes.

The two files are merged into the new file data_merged.usb.

Note If you attempt to merge two files that were recorded in separate 
recording sessions, the following error message appears: 
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7.  Display Options
You can select what information to display in Trace Views using the 
Display Options window.

To open the Display Options window: 

• Select Display Options under Setup on the Menu Bar.
OR

• Click on the Tool Bar.:

You can select General, Color/Format/Hiding, and Level Hiding display 
options. The following sections describe these display options.
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7.1  General Display Options
You specify the main Trace View information types and settings using 
General Display Options (see figure on previous page): 

• Zoom Level: Zooms out from 100% (default) to 10% or zooms in 
from 100% to 200%.

• Enable Tips: Pops up text when you position the cursor over a 
field.

• Wrap: Wraps lines of traffic information instead of truncating lines 
at the right edge of the display.

• Right click cell context menu: By default, clicking the left mouse 
button on a field heading displays a context-sensitive pop-up menu 
providing commands about the field and clicking the right mouse 
button pops up a menu with display options. After selecting this 
option, clicking the right mouse button on a field heading displays 
the context-sensitive pop-up menu and clicking the left mouse 
button does nothing.

• Hierarchy Lines: Displays lines on the left side of Trace View 
showing the hierarchy from Packets to Transactions to 
Split Transactions to Transfers if you show higher-level decodes.

• Timestamp Position: Aligns the Timestamp field 
"At the beginning" (in a column on the left side of the Trace View), 
"At the end" (in a column on the left side of the Trace View), or 
"Merge with Packet/TRanmsaction/Translation". Selecting this 
option allows easier comparison with previous or following 
timestamps.

• Expand Packet Data Fields by default: Displays packet data 
fields in expanded mode. If this option is not selected, packet data 
fields display in collapsed mode, and you can expand them 
manually.

• Allow any Toggle value after Bus Reset (Int and Bulk 
Endpoints): Depending on the device, after Bus Reset the endpoint 
toggle state might or might not be reset. Selecting this option 
prevents display of a toggle violation error. 

• Expand Script-Based Decoded Info by default: Displays 
decoded transfer fields in expanded mode. If this option is not 
selected, decoded transfer fields display in collapsed mode, and you 
can expand them manually.
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• 2-stage SOF Hiding: You can display all SOFs, hide all SOFs, or 
hide empty SOFs (show only SOFs with endpoint traffic and hide 
empty frames). Selecting this option allows you to hide empty 
SOFs with one click of the Hide SOF button or hide all SOFs with 
two clicks of the Hide SOF button.

• Error Report: Displays the Errors section of the Traffic Summary 
window. 

• Timing Calculator: Displays the Timing Calculator window from 
the beginning of a packet or marker to the beginning of another 
packet or marker, including Total Time unit, Bus Utilization Time 
and Bandwidth, and selected Global, Low Speed, Full Speed, High 
Speed, Transactions, and Devices. 

• Traffic Summary: Displays the Traffic Summary window, 
showing all reports, including Packets, Transactions, Transfers, and 
Errors. 

• Bus Utilization: Displays the Bus Utilization window, including 
Packet length, Bus usage, and Bus usage by device. 

• Navigator: Displays the Navigation bar, including 
Pre/Post Triggers, Errors, and Types of Traffic. 

• Real-Time Statistics: Displays the Real-Time Statistics window, 
including Data Packet Count, Data Payload Throughput, and 
Bus Usage. 

• Trace Viewing Level: Displays Packets, Transactions, 
Split Transactions, Transfers, Host Wire Adapter Segments, Host 
Wire Adapter Transfers, Device Wire Adapter Segments, or Device 
Wire Adapter Transfers.

• Fonts: Sets the font type and bold or italic style for Fields and Data.

• Configuration Name: You can name the current set of 
Display Options values for use with an .opt file. (The options file 
can have a different name.)

• Restore Factory Presets: Sets all Display Options values to the 
installed values. 
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7.2  Color/Format/Hiding Display Options
To modify the colors, formats, and hiding options, select the 
Color/Format/Hiding tab. 

Color Display Options

The program uses a default set of colors for each type of data in each group 
of data. The colors and color combinations are appropriate for most graphic 
systems. You can alter any color.

To specify a color for an information type, in the Color/Format/Hiding tab, 
select a row (such as Data) in the Group and Color column and expand it. 
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Select a data type (such as Data Length) in the Group, then select a color in 
the Color section, using Standard or Custom colors. Use a bright color for 
each important field. 

To customize colors, use the Custom tab.
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Note You cannot change the color of an Invalid Data (packet error) 
field. It is permanently set to red.

Formats Display Options

For each type of data in each group of data, the program has a default data 
format. Examples of number data formats are Bin (binary), Dec (decimal), 
and Hex (hexadecimal). Examples of date and time data formats are Hex 
uFrame, Dec uFrame, Date & Time, Time, Bit Time, seconds, 
microseconds, and nanoseconds. An example of a text data format is ASCII. 
You can alter some data formats.

To specify a data format for an information type, in the 
Color/Format/Hiding tab, select a row (such as Packet Fields) in the Group 
and Color column and expand it. 

Select a data type (such as PID Types) in the Group: 
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Select a format in the Format section. The following formats are available 
for PID Types: 

If available, select Bit Order in the Format section. The options are MSB to 
LSB or LSB to MSB.

 Hiding Display Options

By default, no data is hidden. You can hide any group of data and any type 
of data. You can hide transactions, SOFs; NAKs; High, Full, or Low Speed 
packets; traffic from one or both recording channels; and Addresses and 
Endpoints.

To hide one or more fields, select the Group and Data type in the Group and 
Color column, then click the Hidden checkbox in the display or the Hidden 
checkbox in the Hidden section of the Format section. 
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7.3  Level Hiding Display Options
By default, no data packets, transactions, or bus conditions are hidden. You 
can hide: 

• Start of Frame packets

• NAK’ed transactions

• Chirp and SEO Bus conditions

• High, Full, or Low Speed packets

• Channel 0 or Channel 1 packets

Select the Level Hiding tab, then select the data types to hide.
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7.4  Saving Display Options
You can save a set of Display Options values, make a set the default settings, 
or use a saved set of values with the commands at the bottom of the Display 
Options window: 

• To save the current Display Options values in an options file for use 
in future sessions, click Save. Enter a file name without a file name 
extension. The program adds the .opt extension. (The file must 
have an .opt file name extension.)

• To load a previously saved .opt file, click Load and select a file 
name.

• To save the current Display Options values in the default.opt 
options file for use as the default display options, click Save as 
Default. (Do not delete the default.opt file.)

• To apply the current Display Options values, click Apply. The 
Display Options window remains open.

• To apply the current Display Options values and close the Display 
Options window, click OK.

• To cancel unsaved changes to display values and exit the Display 
Options window, click Cancel. 
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8.  Reading a Trace

8.1  Trace View Features
• The USBTracer packet view display makes extensive use of color 

and graphics to fully document the captured traffic.

• Packets are shown on separate rows, with their individual fields 
both labeled and color coded. 

• Packets are numbered (sequentially, as recorded), time-stamped 
(with a resolution of 16.67 ns), and highlighted to show the 
transmitted speed (low-speed, full-speed or high-speed).

• Display formats can be named and saved for later use. 

• Pop-up Tool Tips detail the contents of  packet fields.

• Data fields can be collapsed to occupy minimal space in the display 
and you can zoom in and out to optimize screen utilization. 

• The display software can operated independently of the hardware 
and so can function as a stand-alone Trace Viewer that may be 
freely distributed.
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• High Speed SOFs display Microframes (shown below.)

8.2  Set Marker
You can define a unique Marker for each packet. 

To place a marker on a packet: 

Step 1 Left-click Packet # for the packet you wish to mark to display the 
Packet menu: 

Step 2 Select Set Marker.

You see the Edit Marker Comment window where you can enter a 
unique comment about this packet.:

Step 3 Enter your comment. 

Step 4 Click OK.

A marked packet is indicated by a vertical red bar along the left edge of the 
packet # block: 

Microframes
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8.3  Edit or Clear Marker
To clear or edit the comments associated with a packet marker: 

Step 1 Left-click Packet #  to display the Packet menu: 

Step 2 To edit the Marker Comment, select Edit Marker Comment to 
display the Edit marker comment window. Edit the comment, then 
click OK: 

Step 3 To clear a Marker, click Clear Marker.

The vertical red Marker bar disappears.

8.4  View Raw Bits
You can expand a specific packet to view the raw bits in detail. 

To view the raw bits: 

Step 1 Left-click Packet # for the packet you wish to view to display the 
Packet menu: 
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Step 2 Select Show Raw Bits to display the Raw Bits View for that packet: 

Along the top of the Raw Bits View is a linear strip of the logical bit values 
with corresponding field demarcations. Bit stuffing is displayed in color. 
Below the logical bit values is a representation of the D+/D- signaling 
complete with NRZ encoding. A scroll bar assists in navigation of larger 
packets. Two buttons under the label Packet are used to view previous or 
next packets. Two buttons under the label Zoom allow you to zoom in or 
out on packets.

8.5  Expanding and Collapsing Data Fields
You can expand a Data field to view it in greater detail or collapse it when 
you want a more compact view. 

Using the Expand/Collapse Data Field Arrows

Data Fields can be easily expanded or 
collapsed by clicking the small triangular arrows 
on the left side of the data field.

Double-Clicking to Expand/Collapse Data Fields

Data fields can also be expanded or collapsed by double-clicking anywhere 
in the data field.
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Expanding or Collapsing All Data Fields

Expand or collapse all data fields by holding down the button for more than 
a second. 

Using the Data Field Pop-up Menus

Data fields can expanded or collapsed by clicking in a data field and 
selecting Expand Data or Collapse Data from the pop-up menu.

To expand and collapse data using the menu: 

Step 1 Left-click Data in the Data packet you want to expand or collapse.

If your Data Trace View is currently expanded, you see the Collapse 
Data menu:

If your Data Trace View is currently collapsed, you see the Expand 
Data menu:

Step 2 Select the desired Expand Data or Collapse Data menu item.

The Trace View is repositioned with the selected packet(s) adjusted 
in the format you have specified.
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Expand or Collapse All Data Fields
All data fields can be expanded or collapsed by selecting Expand All Data 
Fields or Collapse All Data Fields from the data field pop-up menus.

8.6  View Data Block
The data field pop-up menu has an option for 
viewing the raw bits in a data field. 

To view these bits: 

Step 1 Click in the data field to open the data 
field pop-up menu.

Step 2 Select View Data Block.to open the 
Data Block dialog box. 

The View Data Block window has options for displaying the raw 
bits in different formats:

• Format: Lets you display data in Hex, Decimal, ASCII or Binary 
formats

• Show Per Line: Lets you control how many bits are displayed 
per line

• Bit Order: Most Significant Bit, Least Significant Bit
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8.7  Pop-up Tool-tips
Many fields within the trace display pop-up tool-tips when the mouse 
pointer is suspended over them. These tips provide added details about the 
field. 

8.8  Hide SOF Packets
You can hide Start-of-Frame (SOF) packets that may be uninteresting in a 
given context from a Trace View by clicking the Hide SOF Packets button 
on the Tool Bar:

• Click to hide all SOF packets.

8.9  Hide NAKs
You can hide NAKs that may be uninteresting in a given context from a 
Trace View by clicking the Hide NAKs button on the Tool Bar:

• Click to hide all NAK packets.

8.10  Hide Devices
Click the button to open a menu for select any address/endpoint combination 
to be hidden. Hit the Ctrl key to select multiple values. This menu can be moved 
from its default location and floated in the trace window for later use.

8.11  Hide Chirps
Click the button to hide any Chirped-J or Chirped-K packets recorded in a 
USB trace.
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8.12  Switch to Transactions View
A Transaction is defined in the USB specification as the delivery of service 
to an endpoint. This consists of a token packet, an optional data packet, and 
an optional handshake packet. The specific packets that make up the 
transaction vary based upon the transaction type. 

The program default display mode is Packet View. Before you can view 
decoded transactions, you must switch from Packet View to Transactions 
View.

To select Transactions View:

Step 1 Click to on the toolbar.

The Trace View screen is re-drawn to display Transactions. 

Note This menu selection displays a check next to Show USB 
transactions when you have selected it. When you want to 
switch back to Packet View mode, right-click anywhere in the 
trace window and then left-click Show USB transactions.
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You can also switch to Transaction View from the Menu Bar:

Step 1 Select Display Options under Setup to display the Display Options 
General window: 

Step 2 Check Transactions.

Step 3 Click OK.
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8.13  View Decoded Transactions
Once you set Display Options, the Trace View screen is re-drawn to display 
decoded transactions in the colors and format you selected.

When you instruct the Analyzer to display USB transactions, the 
components of each transaction are collected from the current recording and 
are grouped and indented below each decoded transaction. Each row shows 
a transaction with a unique numeration, a label, and color-coded decoding 
of important data.

Expanded and Collapsed Transactions

You can expand a specific transaction to view its parts, which are grouped 
and indented below the transaction. 

To expand a transaction: 

Step 1 Left-click the transaction number you wish to view to display the 
Expand Transaction menu: 
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Step 2 Select Expand This Transaction.

The screen displays the selected transaction in expanded format.

Note The Expand/Collapse transaction feature operates as a toggle: 
when one format is active, the other appears as an option on the 
Expand/Collapse drop-down menu. 

To collapse a transaction, perform the same operation and select Collapse 
This Transaction. 

Note that you can choose to expand or collapse 

• Only the selected Transaction
OR

• All Transactions

It is not necessary to use the Expand/Collapse Transactions menu to shift 
between expanded and collapsed views of a transaction: 

• Double-click in the Transaction number field to toggle back and 
forth between collapsed and expanded views.

8.14  Switch to Split Transaction View
To select Split Transaction View: 

Step 1 Click the button on the toolbar.

The Trace View screen is re-drawn to display Split Transactions.
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You can also switch to Split Transactions View from the Menu Bar:

Step 1 Select Display Options under Setup.

You see the Display Options General window:

Step 2 Check Split Transactions.

8.15  Switch to Transfer View
A Transfer is defined in the USB specification as one or more transactions 
between a software client and its function. USB transfers can be one of four 
kinds: Control, Interrupt, Bulk, and Isochronous. USBTracer™ is capable 
of displaying all four types.

The default display mode is Packet View. Before you can view decoded 
transfers, you must switch from Packet View (or Transaction View) to 
Transfer View.
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To select Transfer View: 

Step 1 Click on the toolbar.

The Trace View screen is re-drawn to display Transfers.

Note Selecting Show USB transfers adds a check next to this menu 
item. If you want to return to Packet View, open the menu and 
reselect Show USB transfers. This action removes the check 
and returns the display to Packet View.

You can also switch to Transfer View from the Menu Bar:

Step 1 Select Display Options under Setup to display the Display Options 
General window: 

Step 2 Check Transfers.

Step 3 Click OK.
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8.16  View Decoded Transfers
Once you set Display Options, the Trace View screen is re-drawn to display 
decoded transfers in the colors and format you selected.

When you instruct the Analyzer to display USB transfers, the components 
of each transfer are collected from the current recording and are grouped 
below each decoded transfer. Each transfer row shows a transfer with a 
unique numeration, a label, and color-coded decoding of important data.

Expanded and Collapsed Transfers

You can expand a specific transfer to view its parts, which are grouped and 
indented below the transfer. 

To expand a transfer: 

Step 1 Left-click the transfer number you wish to view to display the 
Expand Transfer menu: 
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Step 2 Select Expand This USB Transfer to display the selected transfer 
in expanded format. 

Note The Expand/Collapse transfer feature operates as a toggle: when 
one format is active, the other appears as an option on the 
Expand/Collapse drop-down menu. 

To collapse a transfer, perform the same operation and select Collapse This 
USB Transfer. 

Note that you can choose to expand or collapse 

• Only the selected Transfer
OR

• All Transfers

It is not necessary to use the Expand/Collapse Transfers menu to shift 
between expanded and collapsed views of a transfers: 

• Double-click in the Transfer number field to toggle back and forth 
between collapsed and expanded views.

8.17  Decoding Protocol-Specific Fields in 
Transactions/Transfers

When transfers or transactions are displayed, the fields in setup transactions 
or control, interrupt, and Bulk transfers by default do not get decoded and 
are shown in hexadecimal values. The exceptions are setup transactions and 
control transfers for standard USB device requests which are always 
decoded.
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In order to show specific decoding for class- and vendor-specific device 
requests and endpoints, you have to use the decoding association 
mechanism that is described in Chapter 9 on decoding. When you have 
performed the association, you see the protocol-specific fields of transfers 
and transactions decoded in the trace view.

8.18  Switch to Host Wire Adapter Segment View
A Host Wire Adapter Segment is one or more transfers between a PC and 
a host wire adapter. To view host wire adapter segments, switch to the Host 
Wire Adapter Segment trace viewing level.

To select the Host Wire Adapter Segment trace viewing level: 

• Click on the toolbar.

OR

Select View > Show Host Wire Adapter Segment.

OR

Select Setup > Display Options to display the Display Options 
window, check HWA Segment, and then click OK.

The program redraws the trace view. 
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8.19  Switch to Host Wire Adapter Transfer View
A Host Wire Adapter Transfer is one or more wire adapter segments or 
one or more transfers between a PC and a host wire adapter. To view host 
wire adapter transfers, switch to the Host Wire Adapter Transfer trace 
viewing level.

To select the Host Wire Adapter Transfer trace viewing level: 

• Click on the toolbar.

OR

Select View > Show Host Wire Adapter Transfer.

OR

Select Setup > Display Options to display the Display Options 
window, check HWA Transfer, and then click OK.

8.20  Switch to Device Wire Adapter Segment View
A Device Wire Adapter Segment is one or more transfers between a PC 
and a device wire adapter. To view device wire adapter segments, switch to 
the Device Wire Adapter Segment trace viewing level.

To select the Device Wire Adapter Segment trace viewing level: 

• Click on the toolbar.

OR

Select View > Show Device Wire Adapter Segment.

OR

Select Setup > Display Options to display the Display Options 
window, check DWA Segment, and then click OK.
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8.21  Switch to Device Wire Adapter Transfer View
A Device Wire Adapter Transfer is one or more wire adapter segments or 
one or more transfers between a PC and a device wire adapter. To view 
device wire adapter transfers, switch to the Device Wire Adapter Transfer 
trace viewing level.

To select the Device Wire Adapter Transfer trace viewing level: 

• Click on the toolbar.

OR

Select View > Show Device Wire Adapter Transfer.

OR

Select Setup > Display Options to display the Display Options 
window, check DWA Transfer, and then click OK.

8.22  Using the Trace Navigator
You can use the Trace Navigator to show the structure of the 
entire trace from different points on the Trace view, thereby 
refining the trace view to a packet range in the trace that is 
most interesting to you. This range can be set by you to show 
smaller parts of the trace. 

To display the Navigator bar, click in the toolbar or 
select the Navigation Bar checkbox in the Display Options 
General window. 

The Navigator bar can be repositioned in the trace and can be 
oriented horizontally or vertically, docked or undocked by 
dragging the parallel bars at the top or side of the Navigator 
bar. By default, the Navigator bar appears vertically to the 
right of the trace window. 

The Navigator bar represents different types of trace 
information in the order of the packets. The top of each bar 
corresponds to the first packet in the trace, and the bottom 
corresponds to the last packet. The Navigator bar is made up 
of three parts: Pre and Post-Trigger traffic, errors, and types 
of traffic. 
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At any time, a line in the navigator bar of one pixel in height represents a 
fraction of the trace data. If the Navigation bar is 400 pixels high, then each 
bar in this example would represent 1/400 of the trace. If the trace had 4000 
packets total, each bar would represent ten packets. In the Types of Traffic 
portion of the navigation bar, the color of the bar would be that of the most 
important item in those ten packets. See "Navigator Bar Attributes" on the 
next pages. 

Drag the square at the top of bottom to set the size of a packet range. Drag 
the entire square to set the packet range to different values. A bubble appears 
showing the packet range while you are setting it. Right-click the Navigator 
to display the pop-up menu. 

• Pre/Post Trigger, Errors, Types of Traffic: Shows or hides 
specific type of traffic from the Navigator. 

• Set Range to Whole Trace: Resets packet range to the entire trace.

• Set Range near Packet number: Sets the packet range near the 
packet where your mouse pointer is positioned in the Navigator bar. 

• Recent Ranges: Displays a history of ranges that were previously 
selected. 
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Navigator Bar Attributes

The traffic types above are shown in order of importance. For example, if a 
NAK’d transaction occurred in the same sample area as a SOF, the NAK 
would take precedence, and the Navigator would show the black bar. 
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9.  Decode Requests

9.1  Class and Vendor Definition Files
LeCroy analyzers use script files to decode class and vendor requests. The 
script files are read when the application is initialized. Once read, the 
analyzer then decodes class and vendor requests as instructed by the files.

.REQ Files and .DSC Files - Represent the old method of decoding. .REQ 
stands for Requests and .DSC stands for Descriptors. This method was 
originally developed for some of LeCroy’s earlier USB analyzers and uses 
fixed definitional structures. LeCroy provides .req files for the following 
requests and classes:

• Standard Requests (standard.req)

• Hub Class (hub.req): No longer used: replaced by Script Decoder 
version .dec files

• HID Class (hid.req)

• Printer Class (printer.req)

• Communications Class (communication.req)

• Audio Class (audio.req)

• Bluetooth USB HCI commands and events (bluetooth.req): No 
longer used: replaced by Script Decoder version .dec files)

• Vendor Request definition file (vendor.req)

To add your own .req file for a Class or Vendor Request: 

Step 1 Use the Notepad application to create and edit your own Request 
Definition file (for example, my_vendor_commands.req).

Note To learn to write such a file, review the Request (.req) files 
provided by LeCroy.

Step 2 Add the name of your Request file to the request.lst file.

Step 3 Click Setup. The decoding menu in the Class/Vendor List appears.
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.DEC Files - Represents the new method of decoding. DEC stands for 
"decoder" and describes both Class and Vendor requests in a C-like 
language. The .DEC files are in the Scripts directory under the application 
directory. Each .dec file stores an endpoint or request decode. When the 
application starts, these files are loaded dynamically. Subdirectories are 
supported.

The following .dec files are provided: 

• Hid

• Mass Storage Class

— SCSI Bulk Protocol

— UFI CBI Protocol

• PTP Still Image Class Requests

• Smart Card

• Standard Requests

• Video Class Requests

• Virtual

• Wire Adapter Class Requests and Radio Control Request

You can create your own .dec file for a Class or Vendor Request. For more 
information on the format of these Script Decoder files and the Script 
Decoding language, read the Script Decoder Manual.
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9.2  Class/Vendor Decoding Options
You can permanently assign a class or vendor decoding for an address 
and/or endpoint or interface in a trace file. Once assigned, the decoding 
occurs automatically when you display transactions.

Mapping Request Recipient to Class/Vendor Decoding

To assign a decoding group to a request recipient, 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the 
USB Device Request menu:

Step 2 Select Map Request Recipients to Class/Vendor Decoding to 
display the Request Recipient and Endpoints dialog box: 

The Recipient field shows all Class and Vendor Request Recipients 
found in the trace file. The display shows the Host, Address, and 
Type (Class or Vendor) for the recipient. On the right are the names 
of Class/Vendor Decoding groups currently assigned to recipients. 
If blank, no decoding is assigned for a recipient. 

Step 3 Select a recipient.
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Step 4 Display the Class/Vendor Decoding Groups drop-down menu.

The drop-down menu lists the defined Class/Vendor request 
decoding groups. The Class/Vendor Decoding Groups are:

• No Decoding

• Audio Class

• Communication Class

• HID Class

• HUB Class Requests

• Mass-Strg Bulk-only Requests

• Mass-Strg Class UFI CBI Requests

• Printer Class

• PTP Still Image Class Requests

• Standard Requests

• Video Class Requests

• Wire Adapter Radio Control Requests

• Wire Adapter Class Requests

Step 5 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 6 Repeat the previous steps for additional recipients.

Step 7 To retain a mapping from trace to trace DURING an application 
session, select the Keep Across Recordings checkbox.



 115

  USBTracer/Trainer User ManualLeCroy SW Version 2.20

Step 8 Click OK.

Mapping Endpoint to Class/Vendor Decoding

To assign a Class/Vendor Endpoint decoding, 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the 
USB Device Request menu.

Step 2 Select Map Endpoint to Class/Vendor Decoding to display the 
Request Recipients and Endpoints dialog box.

Step 3 Click the  Endpoints tab to display the Endpoints dialog box. 

The Endpoint field (Endp) shows all Endpoints found in the trace 
file. The displays shows the Host, Address, and Direction for the 
recipient. On the right are the names of Class/Vendor Endpoint 
Decoding groups currently assigned to endpoints. If blank, no 
decoding is assigned for a recipient. 

Step 4 Select an endpoint.
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Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu: 

The Class/Vendor Endpoint Decoding options for an OUT endpoint 
are: 

• No Decoding

• CCID Bulk Out Message

• Display DATA

• Mass Strg Bulk-Only SCSI Out Endp

• Mass Strg UFI_CBI Bulk Out Endp

• PTP Still Image Bulk Out

• Video Bulk Out

• Video Isoch Out

• Virtual UART

• Wire Adapter Data Transfer Out Endp
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The Class/Vendor Endpoint Decoding options an IN or Interrupt 
endpoint are: 

• No Decoding

• CCID Bulk In Message

• Communication Class Notification

• Display DATA

• HID In Endp

• Hub Class Status Change Endp

• Mass Strg Bulk-Only SCSI In Endp

• Mass Strg CBI Interrupt Endp

• Mass Strg UFI_CBI Bulk In Endp

• Mass Strg UFI_CBI Interrupt Endp

• PTP Still Image Bulk In

• PTP Still Image Interrupt

• Video Bulk In

• Video Interrupt

• Video Isoch In

• Virtual UART

• Wire Adapter Radio Notif Endp

• Wire Adapter Data Transfer In Endp

• Wire Adapter Notif Endp

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional endpoints you would 
like to map.

Step 8 To retain a mapping from trace to trace DURING an application 
session, select the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Request RPipe to Class/Vendor Decoding

Before mapping Request RPipes to Class/Vendor Decoding, you must first 
assign the following endpoint decoders:

• Wire Adapter Data Out

• Wire Adapter Data In

• Wire Adapter Notif

To assign a decoding group to a Request RPipe: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the 
USB Device Request menu. 

Step 2 Select Map RPipe to Class/Vendor Decoding to display the 
Request Recipient and Endpoints dialog box.

Step 3 Click the Request RPipes tab to display the Request RPipes dialog 
box:  

The Recipient field shows all Class and Vendor Request recipients 
found in the trace file. The RPipe field shows all Class and Vendor 
Request RPipes found in the trace file. The displays shows the 
Otg Host, HWA address, and Type (Class or Vendor) for the 
recipient. On the right are the names of Class/Vendor Decoding 
groups currently assigned to recipients. If blank, no decoding is 
assigned for a recipient. 

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. 
The Class/Vendor Decoding Groups are the same as for Request 
Recipients.
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Step 6 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application 
session, select the Keep Across Recordings checkbox.

Step 9 Click OK.

Mapping Endpoint RPipe to Class/Vendor Decoding

To assign a Class/Vendor Endpoint RPipes decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the 
USB Device Request menu.

Step 2 Select Map Endpoint RPipe to Class/Vendor Decoding to display 
the Request Recipients and Endpoints dialog box.

Step 3 Click the Endpoint RPipes tab to display the Endpoint RPipes 
dialog box: 

The RPipe field shows all RPipes found in the trace file. The 
displays shows the Otg Host, HWA address, and Direction for the 
recipient. On the right are the names of Class/Vendor Endpoint 
Decoding groups currently assigned to endpoints. If blank, no 
decoding is assigned for a recipient.

Step 4 Select an endpoint RPipe.
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Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu. 
The Class/Vendor Endpoint Decoding options are the same as for 
Endpoints.

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional RPipes you would like 
to map.

Step 8 To retain a mapping from trace to trace DURING an application 
session, select the Keep Across Recordings checkbox.

Step 9 Click OK.

Mapping Request DWA RPipe to Class/Vendor Decoding

Before mapping Request DWA RPipes to Class/Vendor Decoding, you 
must first assign the following endpoint decoders:

• Wire Adapter Data Out

• Wire Adapter Data In

• Wire Adapter Notif

To assign a decoding group to a Request RPipe: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Control Transfer field to display the 
USB Device Request menu. 

Step 2 Select Map DWA RPipe to Class/Vendor Decoding to display the 
Request Recipient and Endpoints dialog box.
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Step 3 Click the Request DWA RPipes tab to display the Request DWA 
RPipes dialog box:  

The Recipient field shows all Class and Vendor Request recipients 
found in the trace file. The RPipe field shows all Class and Vendor 
Request RPipes found in the trace file. The displays shows the Otg 
Host, HWA address, and Type (Class or Vendor) for the recipient. 
On the right are the names of Class/Vendor Decoding groups 
currently assigned to recipients. If blank, no decoding is assigned for 
a recipient. 

Step 4 Select a recipient.

Step 5 Display the Class/Vendor Decoding Groups drop-down menu. 
The Class/Vendor Decoding Groups are the same as for Request 
Recipients.

Step 6 Select a decoding group.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for additional recipients.

Step 8 To retain a mapping from trace to trace DURING an application 
session, select the Keep Across Recordings checkbox.

Step 9 Click OK.
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Mapping Endpoint DWA RPipes to Class/Vendor Decoding

To assign a Class/Vendor Endpoint DWA RPipes decoding: 

Step 1 Click the Apply Decoding Scripts button on the Toolbar.

OR

Left-click the Bulk/Int Transfer field to display the 
USB/WUSB Device Request menu.

Step 2 Select Map Endpoint RPipe to Class/Vendor Decoding to display 
the Request Recipients and Endpoints dialog box.

Step 3 Click the Endpoint RPipes tab to display the Endpoint RPipes 
dialog box: 

The RPipe field shows all RPipes found in the trace file. The 
displays shows the Otg Host, HWA address, and Direction for the 
recipient. On the right are the names of Class/Vendor Endpoint 
Decoding groups currently assigned to endpoints. If blank, no 
decoding is assigned for a recipient.

Step 4 Select an endpoint DWA RPipe.

Step 5 Display the Class/Vendor Endpoint Decoding drop-down menu. 
The Class/Vendor Endpoint Decoding options are the same as for 
Endpoints.

Step 6 Select the type of decoding.

OR 

Select No Decoding if you do not want any specific decoding.

Step 7 Repeat the previous steps for any additional RPipes you would like 
to map.



 123

  USBTracer/Trainer User ManualLeCroy SW Version 2.20

Step 8 To retain a mapping from trace to trace DURING an application 
session, select the Keep Across Recordings checkbox.

Step 9 Click OK.

9.3  General Options
Commands are transferred on USB using special control transfers called 
USB Device Requests. The Analyzer can decode Device Requests as they 
are defined in the USB specifications and various Device Class and Vendor 
specifications.

Each USB Device Request is sent using a Control Transfer. Each Control 
Transfer starts with a SETUP transaction.

Decoding USB Device Requests

To decode a USB Device Request: 

Step 1 Left-click the Control Transfer field or the SETUP field of the 
USB Device Request to display the USB Device Request menu: 

Note The menus shown in this section are context-sensitive. You may see 
slightly different menus. 

Step 2 To refresh decoding, click Refresh Decoding for this Trace File. Use 
this option to reanalyze all transactions. 
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Step 3 To use the previous decoding, click Load most recent decoding 
mapping. 

This option loads the most recent mapping of endpoints/requests to 
decoding types that was done on a previous trace. If the endpoints of 
the new trace are the same as the last one mapped, the mappings are 
applied to the current trace. This saves the user from having to 
constantly apply the mapping to a new trace every time the 
application is restarted and a new trace created. 

The ability to retain the mapping from trace to trace DURING an 
application session already exists: the Keep Across Recordings 
button in the endpoint map dialog. This new feature simplifies the 
process when the application has been re-started. 

Note: You can also change the format, color, and hidden status of fields, 
using the same methods as in Display Options. (See Chapter 6, 
Display Options.)
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Decoding Standard Requests

To decode a standard request: 

Step 1 From the USB Device Request menu, select Decode Standard 
Request to display the View Fields for Standard Request text box: 

Step 2 To find a word in the text box, click the Find button. Enter the word 
in the Find What field. To use a case-sensitive search, check Match 
Case. To find only the exact word, check Match Whole Word 
Only. You can search Up or Down. To search, click Find Next.

Step 3 To save the View Fields text box as an HTML file, click the Save As 
button, enter a file name in the Save As dialog box, then click Save.

Step 4 To view the previous or next Transfer Control field request of the 
same request type, click Previous or Next.

The View Fields for Standard Request dialog box displays field definitions 
and values of the Standard Request. 
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For field definitions, please refer to the Universal Serial Bus Specification, 
version 2.0. The USB specification is available from the USB Implementers 
Forum (USB-IF) at: 

Decoding Class Requests

Examples of a class request are Mass-Strg Class UFI CBI Requests, 
PTP Still Image Class Requests, Video Class Requests, and Wire Adapter 
Class Requests. 

To decode a class request: 

Step 1 From the USB Device Request menu, select Decode ... Request to 
display the View Fields for ... Class Requests text box.

The following figure shows a Wire Adapter Class Requests decoding:

Decoding Vendor Requests

To decode a vendor request: 

• From the USB Device Request menu, select Decode ... Request to 
display the View Fields for ... Vendor Requests text box.

An example of a vendor request is UWBTracer™ Command Set. 

USB Implementers Forum
1730 SW Skyline Blvd. 
Suite 203
Portland, OR 97221

Tel: +1/503.296.9892
Fax: +1/503.297.1090
Web: http://www.usb.org/
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Decoding Undefined USB/WUSB Device Requests

A Decoding Request may not belong to any of the defined decoding groups 
(Standard, Class, or Vendor).

Decoding using Endpoint Information

To decode using the endpoint information: 

Step 1 Left-click the Bulk/Int Transfer field to display the 
Bulk/Int Transfer (IN/OUT transaction with data) menu.

Step 2 Select Decode as ... Endp to open a View Fields for ... Endp text 
box.

The following figure shows a Wire Adapter Data Transfer Out Endp 
decoding: 

Changing the Layout of Decode Requests

In the View ... Fields windows, the Decoding Information and the 
Descriptor information blocks (following the Request Summary 
information) have the following columns:

• Field: such as bRequest, wValue, wIndex, bLength, 
bDescriptorType, wTotalLength

• Length in bits

• Offset in bits

• Decoded: hex value typically equal to Hex Value

• Hex Value: hex value typically equal to Decoded

• Description: short description of field
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To change the layout of decode requests display: 

Step 1 Click Layout to display the View ... Fields Dialog Layout dialog 
box: 

Step 2 To display the available columns of data, use the checkboxes for 
Length, Offset, Decoded, Hex Value, and Description.

You can Check All or Uncheck All.

Step 3 To show only the fields of Collapsed mode, check Show only fields 
specified for view in collapsed mode.

Step 4 To retain settings for future viewing of Decode Request fields, check 
Use these settings when View Fields dialog opens.
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10.  Other Features

10.1  Search
The Search feature provides several options for searching through recorded 
traffic, allowing you to find specific packets based on triggering status, 
packet number, marking, or content. 

To view the Search options: 

• Click Search in the Menu 
bar to display the Search 
drop-down menu:

Go to Trigger

Note Go to Trigger is enabled only 
when a trigger has created the 
traffic file.

To display a Trigger Event: 

• Select Go to Trigger under Search on the Menu Bar.

The Trace View is repositioned to the first packet following the Trigger 
event. This packet is at the top of the screen.

Go to Packet/Transaction/Transfer

To display a specific packet: 

Step 1 From the menu bar, select the command 
Search > Go to Packet/Transaction/Transfer
to display the Go to Packet window: 

Step 2 Select the desired viewing level (packet, transaction etc.) from the 
drop-down menu next to the words Go to.

Step 3 Enter the number of the packet you want to display.

Step 4 Click OK.
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The Trace View is repositioned with the selected packet at the top of 
your screen.

Go to Marker

To instruct the Analyzer to display a marked packet: 

Step 1 Select Go to Marker under Search on the Menu Bar.

You see a drop-down menu listing the marked packets in that Trace 
View:

Step 2 Select the desired packet from the displayed list.

The Trace View is repositioned with the selected packet at the top of 
your screen.

Note The Go to Marker feature functions in conjunction with the Set 
Marker feature. The comments within the parentheses 
following each marked packet are added or edited with the Set 
Marker feature. Please refer to Set Marker in Reading a 
Trace.

You can use Ctrl+M to go immediately to the All Markers dialog. 
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Go To

The Go To feature takes you directly to an event in a Trace.

Step 1 Select Go To under Search on the Menu Bar to display the Go To 
drop-down menu:

Step 2 Select the event you want to go to and enter the necessary 
information.

Packet IDs (PIDs)

Select the type of packet to which you want to go.
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Errors
The Errors menu allows you to search for five different types of error: PID, 
CRC5, CRC16, Packet Length, and Stuff Bits. Menu items appear in bold if 
they are present in the trace or are grayed out if not present in the trace, as 
shown in the example below.

You can press Shift+E to go to the first error of any type. 
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Data Length
Allows you to search for data packets of particular lengths. Lengths are 
displayed in Bytes in a drop down menu as shown below. Selecting a length 
causes the display to move to the next instance of that packet length.

Addr & Endp
The Addr & Endp feature allows you to search for the next packet which 
contains a particular address and endpoint. All available address endpoint 
combinations are displayed in the pull down menu.
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Bus Conditions
Allows you to search by bus conditions such as traffic speed, reset, and 
suspend. All available bus conditions are displayed in the pull down menu.
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On-the-Go
Allows you to search for On-the-go attributes. The On-the-Go submenu 
contains entries for:

• HNP: Host Negotiation Protocol

• SRP: Session Request Protocol

• Host: A: Hosts with an A plug

• Host: B: Hosts with a B plug 

Channel
Allows you to search for traffic by 1 (Classic-Speed) or 0 (Hi-Speed).
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Find

Find allows searches to be conducted on an open trace using one or more 
criteria. You can search by packet, transactions, split transaction, transfer, 
by packet type and by fields within packets. 

Find is run by selecting Search >Find or by clicking on the toolbar. 

Searches can combine criteria using the options Intersection and Union. 
Intersection creates AND statements such as "Find all packets with x and 
y." Union creates OR statements such as "Find all packets with x OR y."

You can also perform searches whereby packets or events are excluded from 
a trace. The Exclusion allows searches to be conducted.

To perform a search: 

Step 1 Select Find... under Search on the Menu Bar

OR

Click in the Tool Bar.

You see the User-Defined Find Events screen:

Step 2 Select Packets, Transactions, Split Transactions, Transfers, 
HWA Segments, HWA Transfers, DWA Segments, or DWA 
Transfers, from the top left list box to list that type of event in the 
Events Group box.
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Step 3 Select one or more events from the Events Group box.

Step 4 Select one of the following options:

• Union: Find all packets matching ANY of the specified events. 

• Intersection: Find packets matching ALL of the specified events. 

• Exclusion: Exclude packets matching any of the specified events. 

Exclusion works with the other two options: Select Union AND 
Exclusion (=Exclude packets with ANY of the following fields) 
or Intersection AND Exclusion (=Exclude packets with ALL of 
the following fields.) 

Step 5 If desired, set the search Direction and Origin.

Step 6 Click OK.

After the search finishes, the program displays the packets meeting the 
search criteria.

Find Next

To apply the previous Find parameters to the next search: 

• Select Find Next under Search on the Menu Bar.

OR

Click on the Tool Bar.

Search Direction

Toggles the search forward or backwards. The current direction is indicated 
in the menu.
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10.2  Edit Comment
You can create, view, or edit the 100-character comment field associated 
with each Trace file. These comments are visible in the Windows® Explorer 
if the "Comments" attribute is included in the Details view. 

Step 1 Select Edit Comment under File on the Menu Bar.

You see the Edit comment for trace file window:

Step 2 Create, view, or edit the comment.

Step 3 Click OK.

You can view comments in Windows Explorer by selecting the 
"Comments" attribute. 

10.3  Reports
The Report menu provides several reports to assist you in analyzing USB 
traffic recorded by the Analyzer.
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File Information

To display a File Information report: 

• Select File Information under Report in the Menu Bar.
OR

• Click in the Tool Bar to display the File Information screen: 

The File Information report provides information about how the recording 
was made, what the buffer settings were, what the trigger options were, and 
what version of all the Analyzer hardware was used to make the recording.
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Error Summary

The Error Summary details all errors analyzed throughout the recording.

• Select Error Summary under Report in the Menu Bar
OR

• Click in the Tool Bar to display the Error screen below the 
Trace View:
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Timing Calculations

The Timing Calculator is used to measure timing between any two packets.

• Select Timing Calculations under Report in the Menu Bar
OR

• Click in the Tool Bar to display the Timing and Bus Usage 
Calculator screen: 
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Traffic Summary

Traffic Summary summarizes the numbers and types of packets, 
transactions etc. that occurred in the open trace.

To run Traffic Summary, select Report >Traffic Summary or 

click the button marked . The program prompts you to specify a range 
of packets, then displays the following window: 
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Bus Utilization

The Bus Utilization window displays information on bandwidth use for the 
three recording channels. 

To open the Bus Utilization window, select Report >Bus Utilization or 
click the button marked . A window opens with graph areas:
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Bus Utilization Buttons
The Bus Utilization window has a row of buttons for changing the format of 
the displayed data and for exporting data:

The buttons have the following functions: 

Save As - Saves the graphs 
as a bitmap file (*.bmp) Vertical zoom in

Email - Creates an email 
with a *.bmp file attachment 
of the graphs

Vertical zoom out

Print

Click and Drag zoom - Click diagonally to 
select and zoom in on part of the graph

Full Screen Select Range

View Settings - opens a 
sub-menu with options for 
formatting the display. See 
“View Settings Menu” 
below.

Sync and Graph areas - If two or more 
graphs are displayed, this button 
synchronizes the graphs to one another. Once 
synchronized, the positioning slider of one 
graph moves the other graphs.

Horizontal zoom in

Graph Areas - Presents options for 
displaying additional graphs of data lengths, 
packet lengths, and percentage of bus 
utilized.

Horizontal zoom out
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View Settings Menu
Clicking the View Settings button causes a menu 
to open with options for formatting the display.

• Orient Horizontally: changes the orientation 
of bus usage to horizontal. After selecting 
this option, the menu has Orient Vertically.

• Tile Vertically: tiles the two graphs 
vertically (i.e., side by side). After selecting 
this option, the menu has Tile Horizontally.

• Show Markers: Places "tick" marks along 
the x axis of each graph.

• Show Plumb Line

• Status: Opens a sub-menu with the following 
options:

• Bar: Displays a status bar at bottom of graph.

• Tooltip: Causes a tooltip to appear if you position your mouse 
pointer over part of the graph and leave it there for a couple of 
seconds.

• None: Turns off tooltips and the status bar.

• Grid Lines: Opens a sub-menu with the following options:

— Both: Displays both X and Y axis gridlines

— X Axis: Displays X axis gridlines

— Y Axis: Display Y axis gridlines

— None: Turns off gridlines

• Grid on Top: Moves the grid lines above the graph.
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• Fonts and Colors - Opens a dialog box for setting the colors and 
fonts used in the graphs:

Graph Areas Menu
The Graph Areas menu allows you to view different information in the Bus 
Utilization window. 

To view information: 

Step 1 Click the button to open the Graph Areas menu. 

Step 2 Select the data you want to appear in the Graph Areas window.

Step 3 To make a new graph, click New.
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To change the properties in the Bus Utilizations graph: 

Step 1 In the Graph Area properties dialog box, select what you want your 
graph to display, then click OK.

Step 2 To make a new graph, click New.

Real Time Monitoring

The Real-Time Statistics window displays a graph of real-time link activity.

Real Time Statistics displays a summary of the traffic currently being 
recorded by the analyzer. 
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To display the Real-Time Statistics window, click in the Tool Bar to 
open the Real Time Statistics window: 

In order to see a graph of traffic, you must start recording. 

After starting InfiniBand link activity, press to start the Real-Time 
statistics monitor. As traffic is recorded, data is streamed in real time to this 
window and presented in a format of your choice. 

To stop the monitor, press . 

Real-Time Statistics Buttons
The Real-Time Statistics toolbar has buttons for changing the format of the 
displayed data and for exporting data:

The buttons have the following functions:

Save As - Saves Real-Time 
graphs as bitmap files 
(*.bmp)

Vertical zoom in

Email - Creates an email 
with a *.bmp file attachment 
of the graphs

Vertical zoom out

Print

Click and Drag zoom - Click diagonally to 
select and zoom in on part of the graph

Full Screen Select Range
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Real-Time Statistical Monitor Pop-up Menu
If you right-click a graph in the Real-Time window, 
a pop-up menu appears with options for changing the 
format of the display: 

• Undo Zoom: If you have zoomed in, undoes 
the zoom.

• Fit to Graph Area: Displays graph so that 
the entire trace fits inside the graph area.

• Y Scale Type: 

• Linear: Converts display to linear 
format.

• Logarithmic: Converts display to logarithmic format.

• Hide: Hides the selected graph.

• Properties: Opens a dialog box with options for changing the 
colors, titles and other features of the graphs.

Displaying Multiple Graphs
The Real Time Statistics window gives you the ability to create up to three 
separate graphing windows so that you can create separate graphs of traffic 
and tile them vertically. Within these windows, you can format the graphs 
in a number of ways.

• To view two or three graphs simultaneously, 

click the Graph Areas button. 

View Settings - opens a 
sub-menu with options for 
formatting the display. See 
“View Settings Menu” 
below.

Sync and Graph areas - If two or more 
graphs are displayed, this button 
synchronizes the graphs to one another. Once 
synchronized, the positioning slider of one 
graph moves the other graphs.

Horizontal zoom in

Graph Areas - Presents options for 
displaying additional graphs of data lengths, 
packet lengths, and percentage of bus 
utilized.

Horizontal zoom out

Start. Starts the Real-Time Monitor.

Stop Real-Time Monitoring.

Reset. Resets the graphs.
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The following menu opens.

Selecting a checkbox displays the selected graph type: 

• Statistics Accumulation: Plots the percentage of Link utilization 
by non-idle traffic for both directions of the link.

• Data Packet Count (Packets/s): Plots counts of Data Packets per 
second for both directions of the link.

• Data Payload Throughput (MBytes): Plots data payload 
throughput for both directions of the link.

• Bus Usage: Plots amount of Bus usage. 
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11.  Traffic Generation with USBTrainer

USBTrainer™ is a USB Traffic Generator module that plugs into the right 
slot of the Universal Protocol Analyzer System (UPAS).

USBTrainer is designed to generate USB traffic so that engineers can test 
designs under realistic conditions. Traffic Generation can also be used to 
transmit known bad packets, providing an opportunity for engineers to 
observe how a device handles specific adverse conditions.

USBTrainer Traffic Generation Files

USBTrainer generates USB traffic from traffic generation files (*.utg) 
which are text-based script files that instruct the Generator how to generate 
USB traffic. These script files can be edited with either a simple text editor 
such as Notepad or with the Script Editor utility provided by the 
USBTracer™ application. The Script Editor utility has several aids to 
simplify the process of writing and editing scripts: tool-tips, drop-down 
menus, and colored fields.

The script example below shows the beginning of a traffic generation file 
created through the Export command. This command provides an easy way 
to create a generation file - you open a trace file, then run the Export 
command. The trace serves as a blueprint for the traffic generation file.
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The example below shows several commented lines followed by some 
instructions. 

This generation file causes USBTrainer to simulate a hub and to generate 
24,320 packets. See “Device Emulation” on page 160 for details about the 
format of traffic generation files.

Creating Traffic Generation Files

If you choose to write a script with a text editor, a good way to start is to edit 
the sample generation file that is provided: HS_Hub_Sample.utg. This file 
is located in the same directory as the USBTrainer application (for example, 
C:\Program Files\LeCroy\USBTrainer). You can open this generation 
file with Notepad or other editor and then add or remove text as needed. 

Creating a Traffic Generation File with the Export Command
The Export command on USBTracer offers an easy alternative method of 
creating a generator file. This command converts the trace to a *.utg file, 
removes all device traffic, and leaves only the traffic from the host device. 
You can then use this file to emulate the host and determine whether the 
device under test is generating the correct traffic.

When creating a .utg file through the Export Packets to Text (Generator 
Text File Format) menu selection, it is suggested that you use the default 
values presented. Adding NAK transactions clutters the .utg file, and 
including the device side packets creates a .utg file which does not work 
with a real device attached.

To use the Export command: 

Step 1 Start USBTracer.

Step 2 Open a trace that has the pattern of traffic you would like to generate.
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Step 3 Select File > Export from the menu bar to display the File Export 
menu: 

Step 4 Select Packets to Text (Generator 
Text File Format) from the Export 
drop-down menu.

You see the Export to Generator 
Text window:

Step 5 Enter the numbers of the first and last 
packets in the series.

Note The device packets are removed from 
the exported generator text. This is 
essential in creating a generator text 
file that can be used to handshake 
with your device.

Step 6 You can opt to regenerate the frame numbers and remove the 
NAKed transactions.

Once the generator text file is exported, you may need to edit the file and 
adjust idle time to properly anticipate the responses from your device.
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11.1  Editing a Generation File
A .utg file is a text file that can be edited with any text editor such as 
Notepad. A better editing option, however, is Script Editor, an utility that is 
built into the USBTracer™ application. Script Editor provides the usual 
editing functions such as select, cut, copy, and paste but also adds tool-tips, 
colored keywords, drop-down parameter values, and 
expandable/collapsible packet data fields.

To launch the Script Editor, click the Script Editor button on the 
toolbar or right-click the trace window and choose Edit as Text.

The Script Editor window opens in the lower portion of the trace window. 

The Script Editor divides into three areas: the toolbar, the script window, 
and the file tabs at the bottom of the window. If errors occur, a log opens at 
the bottom of the window.

Toolbar
The Script Editor toolbar contains buttons for saving your edits, navigating, 
searching and other functions. 
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The buttons have the following functions:

View Options Menu
The View Options button has a menu with three options: 

• Enable Outlining: Adds an 
expandable/collapsible tree structure to the left 
side of the Script Editor showing the hierarchical 
relationships of the script lines.

• Show Line Numbers: Adds line numbers to the 
left side of the Script Editor window.

• Show Tooltips: Enables tooltips to appear when the mouse pointer 
is suspended over a script item.

Pop-up Menu
Right click anywhere in the script window to 
open a pop-up menu with the following options: 

• Cut

• Copy

• Paste

• Position Trace View on Packet xxx

• List Values

• Toggle Outlining

Save. Saves your edits and 
immediately updates the setting bars 
and Frames shown in the trace 
window.

Add/Remove bookmark. Allows 
markers to be set or removed to 
aid in navigation.

View Options. Opens a menu with 
three options: Enable Outlining, 
Toggle Outlining, and Line Numbers. 
See View Options Menu below.

Go to next bookmark.

Cut. Go to previous bookmark.

Copy. Clear all bookmarks.

Paste. Find.

Undo. Find and Replace.

Redo. Print.
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The List Values option displays the types of values that can be entered for a 
parameter in a line. To see the types of values, select the current parameter, 
then choose Show Values from the pop-up menu.

File Tabs
At the bottom of the window is a tab that shows the name of the .utg file. If 
your .utg file has an Include statement in it, the supporting Include files 
automatically open when the .utg file is first opened. Tabs for the opened 
Include files appear at the bottom of this window. 

Error Log
Whenever you create a scripting error, a log opens at the bottom of the 
application window. When the error is corrected, the window automatically 
closes. 

Tooltips
The Script Editor window includes extensive tooltips for each keyword. To 
see a tooltip, hold the mouse pointer over a keyword. 

11.2  Loading the Generation File
The USB Traffic Generation files are scripts that instruct the analyzer how 
to generate USB traffic. A traffic generation file contains text in special 
format and is named with a "*.utg" extension. These files can be created by 
any text editor, or using the File > Export > Packets to Text 
(Generator File Format) menu selection when viewing a Trace File. There 
are several examples of Traffic Generation files included with the 
installation of the USBTracer software.
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To load a generation file: 

Step 1 Select File > Open ... from the menu to display the Open dialog box: 

Step 2 Select USB Tracer Generation Files (*.utg) from the drop-down 
menu marked Files of Type to display a list of Traffic Generation 
files.

Step 3 Select a Traffic Generation file (*.utg).

Step 4 Click Open.
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The file opens.

Step 5 Decide how many times you want the traffic 
pattern to be generated, then select a value 
from the Repeat drop-down menu.

The Repeat mode allows for a single pass through the generation 
file, looping forever, or looping 1 to 65,534 times, as desired by the 
user. If a "wrap=HERE" location is found in the .utg file, that 
location is where the looping portion begins. The loop end is at the 
end of the .utg file or up to the "stop=HERE" statement in the file.



 159

  USBTracer/Trainer User ManualLeCroy SW Version 2.20

Step 6 Select the Generation mode in which to generate traffic (see below 
for an explanation) by depressing or undepressing the 

IntelliFrame button on the toolbar: 

• Depressed = IntelliFrame

• Undepressed = Bitstream

Traffic Generation Modes: Bitstream vs. Intelliframe

IntelliFrame and Bitstream are modes that control how the generator 
interacts with other devices when it is generating traffic. 

• Bitstream Mode -In Bitstream Mode, the generator constructs a 
bitstream of traffic based on the UTG file and assumes that packets start 
at pre-calculated times. For example, after an IN packet, the generator 
waits a calculated fixed time before presenting an ACK. The time 
between them is determined by the "idle=" time statement in between the 
IN and ACK packets in the .utg file. In this mode, every bit time of a 
generation stream (including idles and SE0's) is represented by 4 bits of 
data, so the file to be downloaded to the Generator can be very large.

• IntelliFrame Mode - In IntelliFrame mode, the generator can wait for 
Device responses to complete before it continues generating more host 
packets. For example, after issuing an IN, the generator looks for the 
DATAx packet issued by the device to finish, and then issues an ACK. 
This way, the data length can vary and does not need to be pre-calculated. 
Also, using the "idle=TO_EOF" statement allows the generator to 
calculate where the end of the frame occurs, so that a subsequent 
"frame=AUTO" statement creates a Start of Frame at the correct time. 
Moreover, the Generator can be made to retry transactions that are 
NAKed automatically, and to use the PING protocol where appropriate. 
Retries can be made to occur within the same frame or in the next frame. 
For further information on the flexible behavior that can be instituted 
during the generation, see the syntax descriptions for the generation files 
here. An additional advantage of the IntelliFrame mode is that it creates 
an image in the Generator's memory that is MUCH smaller than that of 
the Bitstream mode, so it downloads much faster. 

Note Device emulation only works in Intelliframe mode.

Starting Traffic Generation

To start traffic generation, click on the Tool Bar.
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Repeating a Generation Session

If you wish to repeat a generation session, press the

Traffic Generation Start/Stop button again. There is no need to reload 
the .utg file.

You can make an additional entry in a Generator Text File that allows you 
to specify a portion of the file for repetition: 

• Enter wrap=here in the Generator Text File.

The traffic above the entry is run only once. The traffic below the entry is 
repeated continuously.

Note For a usage example, see the sample file Wrap.utg.

Stop Traffic Generation

To instruct the Analyzer to halt traffic generation: 

• Click on the Tool Bar.

11.3  Device Emulation
Device Emulation is a licensed option that allows USBTrainer to generate 
device-side traffic. Like host traffic generation, device emulation uses 
text-based generation files (.utg) to generate traffic.

Device emulation has three steps: create a generation file, configure 
generation settings, and then generate traffic.

Creating a Generation File

Generation files can be created one of two ways:

• Write a generation script file using either LeCroy's 
context-sensitive script editor or any text editor that you choose.

 OR

• Use a pre-recorded trace file that has the type of traffic that you 
want to generate. This file is a blueprint for the traffic generation 
script file.

If you decide to use a pre-recorded trace file as a generation blueprint, then 
verify that the trace file contains traffic for only one device. If it does not, 
hide all the other devices (Setup > Level Hiding) and save the file as a new 
file without the hidden traffic (File > Save As and check the option Do not 
save hidden packets/transactions/transfers).
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Setting Generation Options

Step 1 Set the Traffic Generation options by configuring the Misc page in 
the Recording Options dialog box:

Setup > Recording Options > Misc

Step 2 In the Misc page, select Device Emulation Mode.

Step 3 Configure Resume settings.

• If you want the simulated device to issue Resumes, then select 
Device Resumes and enter a delay time (in milliseconds). If 
you do not select Device Resumes, then the emulated device 
waits for a Host to issue a Resume.

• If you want the simulated device to take its address from the 
Traffic Generation (.utg) script file, then select 
Use Address in .utg file. This option causes the USBTrainer to 
read the .utg file and assign a Device Address based on the 
device traffic that it sees in the file.

Note In this release, the Device Emulator does not look at the Set 
Address in the script, so if your host controller is running more 
than one device, it may enumerate your device emulator 
incorrectly when you begin to generate traffic. The solution is to 
manually assign a device address. To manually configure the 
Device Address, select Emulated Device's Hex Address and 
enter an address or mask (Note: A mask allows the USBTrainer 
to respond to multiple device addresses.)

Step 4 Click OK to close the Recording Options dialog and apply the 
changes. The generation settings take effect as soon as you execute 
a script.

Run the Traffic Generation Script File

Step 1 Connect the USBTrainer's port B (either Hi Speed or Classic Speed) 
to the Host.

Step 2 Open the Traffic Generation .utg file.

Step 3 Begin traffic generation by clicking .



162

  USBTracer/Trainer User ManualLeCroy SW Version 2.20

When execution begins, USBTrainer reads the entire generation file and 
then parses the generation commands into groups according to their 
endpoints. Each of the parsed groups of commands are then written into 
dedicated memory segments in the generator. Up to eight memory segments 
can be created for the various endpoints. In the case of Endpoint 0 or any 
Control endpoints, a single memory segment is created.

Each memory segment can be thought of as a queue of the commands and 
responses for a particular endpoint that occur in the generation file.

Commands are stored sequentially within each memory segment as they 
occur in the generation file. For example, if a generation file has a sequence 
of command X and Y for the Endpoint 1, the commands are extracted in this 
order and placed in the Endpoint 1 memory segment.

When the host calls for a particular device endpoint response, the first 
command listed in that endpoint memory segment is then executed. With 
each subsequent call to the same endpoint, commands are executed 
sequentially down the list as they occur in the memory segments. For 
example, if three calls were made to Endpoint 0 IN, then the first three 
commands in that endpoint's memory segment would then execute.

Note Each of the endpoint memory segments execute independently: 
there are no behavioral interactions between the individual 
endpoints.

11.4  Format of the Traffic Generation Files
Whether you create a traffic generation from scratch or use the Export 
command in USBTracer, there are a few rules about the format of the 
generation file that you should review. These are presented in this section.
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Traffic is generated from a text file named *.utg. Within the text file: 

• The data format for data fields such as Pids and Raw bits is hex.

• Each packet definition consists of this set of assignments: 
key=value. 

• White space is permitted around the equal sign. 

• There are no restrictions on dividing packet definition to lines nor is 
it necessary to define each packet in a separate line, although it is 
recommended. 

• The maximum number of characters in a line is 250.

• The characters # and; indicate end-of-line comments (i.e. the rest of 
the line is ignored)

• Comments are not allowed within brackets ( ).

• No keys or values are case-sensitive.

Each packet definition starts with one of these assignments: 

• pid=N (where N is a string representing a valid packet identifier or 
an eight bit value)

OR

• frame=N (where N is an eleven bit value of the frame number or 
the strings auto and keep_alive).

A bus condition definition starts with one of these assignments:

• reset=N (where N is a positive integer or string)

• suspend=N (where N is a positive integer)

• resume=N (where N is a positive integer)

• chirp=here

Subsequent assignments after a packet’s starting assignment define the 
values of particular fields within the packet. If a field is not defined, it is 
assumed to be 0. Values are assumed to be decimal unless they are prefixed 
with 0x and then are interpreted as hexadecimal. Values within a data block 
assignment are always assumed to be hexadecimal and should not be 
prefixed by 0x. 



164

  USBTracer/Trainer User ManualLeCroy SW Version 2.20

Table 2: Support Keys for Defining Fields within a Packet
Key Code Format Description

File Control Keys

file_type ’UPAS’

’CHIEF’

This must be included at the beginning of the file to 
determine the speed of packets to be generated. Value 
must be "file_type=UPAS" to allow for High speed 
traffic, IntelliFrame operation, 'expected_pid' and 
'device_pid' key support. Full and Low speed traffic, and 
Bitstream operation are supported on all "file_type=" 
values. If this statement does not appear in the file, the 
default is "file_type=CHIEF", allowing backward 
compatibility with older USB Chief™ .usb files.

file_version integer This must be included after the "file_type=" key to 
determine the version of this file. Value is currently 3. 
Usage: "file_version=3"

file_mode ’HOST’

’DEVICE’

Sets generation mode to host or device. For generation to 
work, this must match the selection found in the 
Recording Options > Misc dialog.

file_speed 'HIGH'

’HI’

’FULL’

'LOW'

This must be included after the "file_version=" key to 
determine the speed of packets to be generated. Values 
are "HIGH', 'HI', 'FULL', or 'LOW'. Example: 
"file_speed=FULL". Only one "file_speed=" is allowed 
per .utg file, but low speed traffic on a full speed bus can 
be created by adding the "speed=LOW" key to a low 
speed packet in a file defined as "file_speed=FULL". No 
other mixing of speeds is allowed. 'HI' is the same as 
'HIGH' and was added to conform to the USB terms.

loop_count
wrap_count

0 through 16382

or "infinite"

These two terms are interchangeable. 

Device Emulation Only. This key defines the loop count 
for each memory segment. Examples: 
"loop_count=INFINITE" or "wrap_count=9"

wrap

loop

’HERE’ This key marks the "wrap point" in the traffic. When 
generation is in Repeat mode, all the traffic before the 
wrap point is going to be sent once, all the traffic after the 
wrap point is going to be repeated in a loop. 

The usage of the keyword is "wrap=HERE" or 
"loop=HERE". For Device Emulation, the value would be 
a memory segment number, so that the looping is 
associated with only that one endpoint, such as "wrap=4".

skip ’HERE’ Causes a region in the .utg file to be ignored, as if 
commented out. Can be used multiple times in the file. 
Must be used in conjunction with "skip_end=HERE". 
Example:

skip=HERE frame=auto makes this statement be ignored!

skip_end=HERE

skip_end ’HERE’ Causes a region in the .utg file to be ignored, as if 
commented out. See above in "skip=HERE".
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stop string If you want to run only some first portion of the 
beginning of a .utg file, insert this statement where you 
want generation to halt. This saves having to edit a file 
into smaller files when testing a portion of traffic. 

The usage of the keyword is "stop=HERE".

break ’HERE’ Host Generation Only. Enables you to generate up to a 
point in the .utg file, then wait for input before continuing 
in the file. During the breakpoint time, the traffic signal 
icon in the toolbar flashes yellow, indicating that a 
breakpoint was hit. When you click the traffic light icon, 
the generation resumes. If you want to stop rather than 
continue, select Stop from the Generation menu or hit the 
Start/Stop button on the front of the generator module. 
Start-of-frames are issued automatically during the 
breakpoint duration. When you resume running, traffic 
begins after another start-of-frame is issued. 

The "break=HERE" statement must be inserted between 
"frame=xxx" statements.

Syntax example: 

frame=AUTO break=HERE frame=AUTO

Endpoint Configuration

begin_config 'HERE' Defines the beginning of the region in the file used to 
configure the endpoint types. The configuration is 
necessary to determine the default behavior of the NAK 
retry mechanism during IntelliFrame operation.Between 
the "begin_config=HERE" and the "end_config=HERE" 
statements is a series of "config_endpoint=xxx" 
statements, which define each endpoint's type and default 
retry behavior. The config region must precede any actual 
packet or bus condition statements. For Device 
Emulation, the config region is mandatory. It provides the 
mapping of the endpoints into their corresponding 
segments of analyzer memory, which contain the traffic 
for those endpoints. When exporting to a .utg file from a 
trace file, these sections are created automatically.
Syntax example: begin_config=HERE

end_config 'HERE' Terminates the region in the file used for configuring the 
endpoints. See "begin_config". 
Syntax example: end_config=HERE

config_endpoint ‘CONTROL’
‘INTERRUPT’
‘ISOCHRONOUS’
‘BULK’

Begins a statement that defines a particular endpoint's 
type, default retry behavior (Host Generation only), and 
memory segment (Device Emulation only) 
Usage example: config_endpoint=BULK addr=1 endp=3 
direction=OUT retry=TRUE
retry_next_frame=FALSE

Key Code Format Description
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endp_mem_seg 1
2
3
4
5
6
7
8

Device Emulation Only. Separates each endpoint 
function into a different queue (also referred to as a 
Memory Segment) of commands and responses. There 
are a maximum of eight of these queues, and each has a 
unique address/direction combination. For control 
endpoints, one queue is shared by both directions of the 
endpoint. Traffic on the Default Endpoint (Address 0, 
Endpoint 0) shares the same queue as the endpoint 0 of 
the selected device address (the address it gets from the 
Host through the SetAddress request). These always use 
"endp_mem_seg=1". These are all set automatically when 
exporting a trace file to a Device Emulation .utg file.

direction ‘IN’ 

‘OUT’
Defines the transfer direction of data for the specified 
endpoint. For all transfer types but CONTROL, there can 
be two distinct logical connections using the same 
address and endpoint. They would differ only in defined 
direction. 
Syntax example: direction=IN

retry ‘TRUE’ 

‘FALSE’
Host Generation Only. Defines whether an automatic 
retry should be performed on packets to/from this 
endpoint in the case that they are NAKed (or in some 
cases 'NYETed'), or if a timeout on device response 
occurs.
RETRY only works for the Pids: Setup, In, and Out.
If 'TRUE', the Trainer automatically retries the specified 
sequence if a Pid is received on the bus which does not 
match the 'expected_pid', or if a timeout occurs. The 
generator re-issues the host packet(s) after waiting either 
1/10th of a frame, or until after the next start-of-frame 
(depending on the value set for 'retry_next_frame') The 
retries continue until the 'expected_pid' is received. When 
a retry attempt finds its 'expected_pid', the Trainer 
automatically generates a new start-of-frame before 
continuing with the rest of the Gen File. (The 
start-of-frame is either an SOF packet or a keep-alive 
signal.) 
If 'FALSE', the Trainer waits for a Pid before proceeding. 
There is no timeout. If a Pid is received which does not 
match the 'expected_pid', the Trainer continues to wait for 
the correct Pid to appear. If the user stops the generation, 
a message states that the generator was waiting patiently 
for the "expected_pid", and it never showed up. The user 
must examine the problem by viewing the trace file.
This statement can also be used in conjunction with any 
"pid=xxx" statement in the .utg file. This can be done to 
override the configured or default retry behavior.
Syntax example: retry=TRUE

Key Code Format Description
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retry_next_frame ‘TRUE’ 
‘FALSE’

Host Generation Only. Determines when a retry will be 
attempted after a failed match of an 'expected_pid'. This 
statement only applies if a "retry=TRUE" statement also 
exists.
If 'TRUE', the Trainer waits until the current frame 
completes, issues a start of frame, and then retries the 
transaction. 
If 'FALSE', the Trainer waits 1/10th of a frame before 
retrying the transaction. Before each retry attempt, the 
Trainer checks to see where in the frame interval it is. If it 
is too close to the EOF, it automatically generates the 
next start-of-frame before performing the retry. If it is not 
too close to the EOF, it performs the retry without 
generating a new frame.
This statement can also be used in conjunction with any 
"pid=xxx" statement in the .utg file. This can be done to 
override the configured or default retry behavior.
Syntax example: retry_next_frame=FALSE

ping_on_retry ‘TRUE’ 
‘FALSE’

Host Generation Only. Determines whether an OUT 
transaction is retried by repeating the OUT-DATAx 
sequence, or whether a PING sequence should be 
initiated.
If 'TRUE', the Trainer automatically generates PINGs 
(and retries) before going through a Retry Loop. PINGs 
are repeated until an ACK is received, and then the 
original OUT-DATAx transaction Sequence is attempted. 
During the PING retries, the trainer automatically 
generates frames. When the original Retry Sequence 
receives its 'expected_pid', the Trainer generates a new 
frame before continuing with the Gen File.
If 'FALSE', the original transaction is always retried.This 
statement can also be used in conjunction with any 
"pid=xxx" statement in the .utg file. This can be done to 
override the configured or default retry behavior.
Syntax example: ping_on_retry=TRUE

ping_after_nyet Host Generation Only. 
If 'TRUE', the Trainer automatically generates PINGs 
(and retries) after receiving a NYET instead of the 
'expected_pid'. This feature is only used if the 
'expected_pid' is an ACK. PINGs are retried until an 
ACK is received. When the PING is ACKed, the Trainer 
generates a new frame before continuing with the Gen 
File. 
If 'FALSE', the Trainer continues as if an ACK occurred. 
This statement can also be used in conjunction with any 
"pid=xxx" statement in the .utg file. This can be done to 
override the configured or default retry behavior.
Syntax example: ping_after_nyet=TRUE

Key Code Format Description
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Packet Starting Keys

pid 8 bits (0-0xFF)

or 

pid string

Host Generation Only. Use this as the first key of most 
packets sent by the Host (Exception: use "frame=" for 
SOF packets). The key should be assigned to a valid 
packet identifier string per the USB specification: 
'SETUP', 'IN', 'OUT', 'DATA0', 'DATA1', 'ACK', 'PRE', 
'PING', 'SPLIT', 'DATA2', or 'MDATA'. Optionally, you 
may assign this key a raw eight bit value to force an error 
condition.

Warning: If you specify PID=0xNN, you must use 
"raw_data=( )" to specify the rest of the packet data, 
because the packet structure is unknown.

expected_pid pid string Host Generation Only. Use this as the PID key for 
packets which are expected to be sent by the device. In 
IntelliFrame mode, the generator waits until this PID has 
completed before sending the next generated packet or 
bus condition. The key should be assigned to a valid 
packet identifier string per the USB specification: 
'DATA0', 'DATA1', 'ACK', 'NAK', 'STALL', 'NYET', 
'DATA2', or 'MDATA'. The generator engine waits 
forever until this "expected_pid" appears, so the user may 
have to hand edit the file to achieve the desired results. 
For example, if a NAK comes where the "expected_pid" 
was a DATA1, the user should edit the .utg file to move 
the "pid=IN" command to later in the file by inserting 
some "frame=AUTO idle=TO_EOF" pairs before it. This 
allows time for the device to be ready for the IN. 

If "RETRY=TRUE" for this address/endpoint, the NAKs 
are ignored and the SOF's are generated automatically 
until the expected PID occurs.

device_pid pid string Use this as the first key of most packets sent by a device. 
The key should be assigned to a valid packet identifier 
string per the USB specification: 'DATA0', 'DATA1', 
'ACK', 'NAK', 'STALL', 'NYET', 'DATA2', or 'MDATA'. 
Normally, the "device_pid=" statement is NOT present in 
a Host Generation .utg file, because the device responses 
are intended to come from real devices. By default, Host 
Generation files exported from Trace Files do NOT 
include "device_pid=" statements. 

Warning: If you specify "PID=0xNN", you must use 
"raw_data=( )" to specify the rest of the packet data, 
because the packet structure is unknown.

Key Code Format Description
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frame 11 bits
or
’AUTO’

’KEEP_ALIVE’

Creates a start of frame packet and generates a SOF PID 
as expected. The key should be assigned a value of the 
frame number, 'AUTO', or 'KEEP_ALIVE'. The string 
'AUTO' instructs the generator to increment the frame 
number automatically. The string 'KEEP_ALIVE' 
instructs the analyzer to generate a low-speed EOP in 
place of a SOF packet for traffic on a low-speed branch 
("file_speed=LOW").

For Device Emulation, this statement is ignored by the 
Device Emulator, but serves to organize the .utg file in a 
more readable manner.

empty_frame integer Host Generation Only. This key creates a sequence of 
start of frame packets with "idle=TO_EOF" values for the 
idle time. This results in N empty frames, where N is the 
integer value specified. 

If the branch speed is LOW, the frames contain only the 
keep-alive standalone EOP's. This key makes for an 
easier to manage .utg file by eliminating the need for 
many lines of "frame=AUTO idle=TO_EOF" statements. 

Usage:

empty_frames=23 ; insert 23 empty frames here

host_exp_pid PID Device Emulation Only. Defines the PID that is 
expected to be received from the Host. The Device 
Emulator waits until this PID has completed before 
sending the next generated packet. The key should be 
assigned to a valid packet identifier string per the USB 
specification: 'SETUP', 'IN', 'OUT', 'DATA0', 'DATA1', 
'ACK', 'PING', 'DATA2', or 'MDATA'. 'PRE' and 'PING' 
are for Hubs only, and are not supported. Each memory 
segment waits forever until it receives the expected PID 
to it's address/endpoint, so the user may have to hand edit 
the file to achieve the desired results. Each endpoint 
memory segment acts independently.

Bus Condition Keys

reset positive
integer
or
’LS_EOP’

Host Generation Only. Indicates the number of 
microseconds that single-ended zeros (SE0) are driven 
onto the bus. Assign a positive integer to this key. This 
key can also be assigned the string 'LS_EOP' to drive two 
low-speed bit times of SE0 followed by one bit time of J.

se0 positive integer
<2500

Host Generation Only. Same SE0 signal as reset, but the 
range is in nanoseconds (accuracy: +/- 33ns).

suspend positive
integer

Host Generation Only. Indicates the number of 
microseconds of idle and suspend after the previous 
packet (e.g., for ten milliseconds of suspend the key 
should equal 13000). Assign a positive integer to this key. 
Note that suspend begins after 3 milliseconds of idle.

Key Code Format Description
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resume positive
integer

Host Generation Only. Indicates the number of 
microseconds of K driven onto the bus. Assign a positive 
integer to this key. For a proper resume sequence, this 
should be followed by the condition 
"reset=LS_EOP speed=LOW". 

wait_resume HERE Host Generation Only. Place this immediately before a 
"resume=<>" statement to implement a device resume, 
also known as Remote Wakeup. This causes the host to 
wait for the device to issue the Resume (K) condition 
before the Host proceeds with its own Resume signalling. 
This statement MUST be followed by the 
"resume=<> statement".

chirp ’HERE’ Used to create a chirp sequence for a High Speed 
generation. 

Usage: chirp=HERE 

wait_vbus ’VALID’ Device Emulation Only. Wait for VBus to go Hi.

termination ’HERE’ Device Emulation Only. Set terminations now.

Keys for Packet Fields

speed ’LOW’ Used to cause a low speed packet on a full speed branch. 
The only legal value is "speed=LOW".

addr 7 bits (0-127) Assign a value for the address field.

endp 4 bits (0-15) Assign a value for the endpoint number field.

hub_addr 7 bits (0-127) Host Generation Only. Assign a value for the 
hub_address field of a SPLIT packet.

port 7 bits (0-127) Host Generation Only. Assign a value for port field of a 
SPLIT packet.

data (AB CD) Assign data bytes for the data field. Use the following 
syntax:

data=(12 34 56 78 90 AB CD EF DC 13 40 78 11 CA 70 
65). 

You can wrap bytes of the data field to the next line. The 
bytes are in the order they come across the bus, and the 
bits within the bytes are in MSB to LSB order. Maximum 
number of bytes allowed is 1049.

crc 5 bits (0x0-0x1F) 
or 

16 bits 
(0x0-0xFFFF)

Assign a value for the crc field. The default value is the 
correct crc calculated for the packet.

s 0 or 1 Host Generation Only. Assign a value for the s (High 
Speed SPLIT Start/Speed) field.

sc 0 or 1 Host Generation Only. Assign a value for the sc (High 
Speed SPLIT Start/Complete) field.

e 0 or 1 Host Generation Only. Assign a value for the e (High 
Speed SPLIT End) field.

et 0-3 Host Generation Only. Assign a value for the et (High 
Speed SPLIT Endpoint Type) field. 
0-Control, 1-Isoch, 2-bulk, 3-Interrupt

Key Code Format Description
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eop positive integer Assign a positive integer for the length of the end of 
packet (EOP). The default value is the correct length
 (2 bits of SE0, 1 bit of J). The value is reflected by 
<val-1> bits of SE0 plus one bit of J.

hi_eop (AB CD) Hex Used to generate a high speed EOP pattern. The bytes are 
in the order they come across the bus, and the bits within 
the bytes are in LSB to MSB order. Maximum number of 
bytes allowed is 13.

idle positive integer

or

’TO_EOP’

Defines the length of idle after the current packet. Assign 
a positive integer or string to this key. The positive 
integer indicates the number of full-speed or low-speed 
bit times. The default value is around 4 bits for Classic 
speeds, and around 150 bits for High speeds.

When this keyword is assigned a string 'TO_EOF', 
USB Chief automatically calculates the amount of idle 
remaining in the frame. When handshaking with a device, 
you can use this keyword to add idle where you anticipate 
a packet being returned from the device. 

The "idle=" key is always associated with the proceeding 
packet or bus condition, so you should not put file control 
keys between the packet or bus condition statement and 
the "idle=" statement.

marker ’string’ Assign a string in quotation marks to be put in the marker 
for the defined packet.

raw_data (aa bb) Use to send a non-modulo 8 number of bits in a classic 
speed 'raw_data' packet. It is only valid in conjunction 
with the 'raw_data' statement. Normally, every bit of the 
array defined in a "raw_data=(xx yy)" type of statement 
would be sent. However, particularly in the case where 
"bit_stuff=off", you need more control over the number 
of bits to be output on the bus. By adding the statement 
"raw_data_bits = 11", only the first 11 bits of the defined 
bytes are sent. 

For the following case, 

raw_data=(8F F0) raw_data_bits=13 

the output bitstream would be: 

1111 0001 0000 1 

(Each byte is described in MSB to LSB format, but is 
output on the wire in LSB to MSB format.)

Key Code Format Description
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raw_data_bits integer Use to send a non-modulo 8 number of bits in a classic 
speed 'raw_data' packet. It is only valid in conjunction 
with the 'raw_data' statement. Normally, every bit of the 
array defined in a "raw_data=(xx yy)" type of statement 
would be sent. However, particularly in the case where 
"bit_stuff=off", you need more control over the number 
of bits to be output on the bus. By adding the statement 
"raw_data_bits = 11", only the first 11 bits of the defined 
bytes are sent. For the following case, 

raw_data=(8F F0) raw_data_bits=13 

the output bitstream would be: 

1111 0001 0000 1

(Each byte is described in MSB to LSB format, but is 
output on the wire in LSB to MSB format.)

bit_stuff ’OFF’

’ON’

Assign the string OFF to disable bit stuffing within the 
current packet. The default value is ON.

sync integer

1-40

Assign an integer from 1 to 40 to represent the sync field. 
The integer is the number of zeros transmitted before the 
one. 

For Low and Full Speed files, the default value is 7 to 
give a sync of '00000001'. 

For High Speed files, the default value is 31 resulting in a 
sync of '00000000000000000000000000000001'.

retry

ping_on_retry

ping_on_nak

retry_next_frame

'TRUE'

'FALSE'

Host Generation Only. These four keys may be applied 
to individual packets, to override the behavior in a given 
instance. Normally, they are used in the 'config_endpoint' 
statement. See their descriptions in the Endpoint 
Configuration section earlier.

Keys for Class Decoding

These keys are populated into the .utg. script file automatically whenever the menu command 
File > Export to .utg file is run. These keys do not need to be edited. 

sd_prod

sd_vend

sd_bm_req_type

sd_interface

sd_host_id

sd_class_code

sd_subclass

sd_protocol

sd_end_sd

Key Code Format Description
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How to Contact LeCroy

Limited Hardware Warranty
So long as you or your authorized representative ("you" 
or "your"), fully complete and return the registration card 
provided with the applicable hardware product or 
peripheral hardware products (each a "Product") within 
fifteen days of the date of receipt from LeCroy or one of its authorized 
representatives, LeCroy warrants that the Product will be free from defects in 
materials and workmanship for a period of three years (the "Warranty Period"). You 
may also complete your registration form via the internet by visiting 
http://www.catc.com/support/register/. The Warranty Period commences on the 
earlier of the date of delivery by LeCroy of a Product to a common carrier for 
shipment to you or to LeCroy's authorized representative from whom you purchase 
the Product.

What this Warranty Does Not Cover

This warranty does not cover damage due to external causes including accident, 
damage during shipment after delivery to a common carrier by LeCroy, abuse, 
misuse, problems with electrical power, including power surges and outages, 
servicing not authorized by LeCroy, usage or operation not in accordance with 
Product instructions, failure to perform required preventive maintenance, software 
related problems (whether or not provided by LeCroy), problems caused by use of 
accessories, parts or components not supplied by LeCroy, Products that have been 
modified or altered by someone other than LeCroy, Products with missing or altered 
service tags or serial numbers, and Products for which LeCroy has not received 
payment in full.

Type of Service Contact
Call for technical support… US and Canada: 1 (800) 909-2282

Worldwide: 1 (408) 727-6600

Fax your questions… Worldwide: 1 (408) 727-6622

Write a letter… LeCroy Customer Support
3385 Scott Blvd.
Santa Clara, CA 95054

Send e-mail… support@catc.com

Visit LeCroy’s web site… http://www.lecroy.com/
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Coverage During Warranty Period

During the Warranty Period, LeCroy or its authorized representatives will repair or 
replace Products, at LeCroy's sole discretion, covered under this limited warranty 
that are returned directly to LeCroy's facility or through LeCroy's authorized 
representatives.

How to Obtain Warranty Service

To request warranty service, you must complete and return the registration card or 
register via the internet within the fifteen day period described above and report 
your covered warranty claim by contacting LeCroy Technical Support or its 
authorized representative. 

You can reach LeCroy Technical Support at 800-909-7112 or via email at 
support@catc.com. You may also refer to the LeCroy website at 
http://www.lecroy.com for more information on how to contact an authorized 
representative in your region. If warranty service is required, LeCroy or its 
authorized representative will issue a Return Material Authorization Number. You 
must ship the Product back to LeCroy or its authorized representative, in its original 
or equivalent packaging, prepay shipping charges, and insure the shipment or 
accept the risk of loss or damage during shipment. LeCroy must receive the Product 
prior to expiration of the Warranty Period for the repair(s) to be covered. LeCroy or 
its authorized representative will thereafter ship the repaired or replacement 
Product to you freight prepaid by LeCroy if you are located in the continental 
United States. Shipments made outside the continental United States will be sent 
freight collect.

Please remove any peripheral accessories or parts before you ship the Product. 
LeCroy does not accept liability for lost or damaged peripheral accessories, data or 
software.

LeCroy owns all parts removed from Products it repairs. LeCroy may use new 
and/or reconditioned parts, at its sole discretion, made by various manufacturers in 
performing warranty repairs. If LeCroy repairs or replaces a Product, the Warranty 
Period for the Product is not extended.

If LeCroy evaluates and determines there is "no trouble found" in any Product 
returned or that the returned Product is not eligible for warranty coverage, LeCroy 
will inform you of its determination. If you thereafter request LeCroy to repair the 
Product, such labor and service shall be performed under the terms and conditions 
of LeCroy's then current repair policy. If you chose not to have the Product repaired 
by LeCroy, you agree to pay LeCroy for the cost to return the Product to you and 
that LeCroy may require payment in advance of shipment.
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General Provisions

THIS LIMITED WARRANTY GIVES YOU SPECIFIC LEGAL RIGHTS. YOU 
MAY HAVE ADDITIONAL RIGHTS THAT VARY BY JURISDICTION. 
LECROY'S RESPONSIBILITY FOR DEFECTS IN MATERIALS AND 
WORKMANSHIP IS LIMITED TO REPAIR AND REPLACEMENT AS SET 
FORTH IN THIS LIMITED WARRANTY STATEMENT. EXCEPT AS 
EXPRESSLY STATED IN THIS WARRANTY STATEMENT, LECROY 
DISCLAIMS ALL EXPRESS AND IMPLIED WARRANTIES FOR ANY 
PRODUCT INCLUDING, BUT NOT LIMITED TO, ANY IMPLIED 
WARRANTIES OF AND CONDITIONS OF MERCHANTABILITY AND 
FITNESS FOR A PARTICULAR PURPOSE, AND ANY WARRANTIES THAT 
MAY ARISE FROM ANY COURSE OF DEALING, COURSE OF 
PERFORMANCE OR TRADE USAGE. SOME JURISDICTIONS MAY NOT 
ALLOW LIMITATIONS ON HOW LONG AN IMPLIED WARRANTY LASTS, 
SO THE PRECEDING LIMITATION MAY NOT APPLY TO YOU.

LECROY DOES NOT ACCEPT LIABILITY BEYOND THE REMEDIES SET 
FORTH IN THIS LIMITED WARRANTY STATEMENT OR FOR INCIDENTAL 
OR CONSEQUENTIAL DAMAGES INCLUDING, WITHOUT LIMITATION, 
ANY LIABILITY FOR THIRD PARTY CLAIMS AGAINST YOU FOR 
DAMAGES, PRODUCTS NOT BEING AVAILABLE FOR USE, OR FOR LOST 
DATA OR SOFTWARE. LECROY'S LIABILITY TO YOU MAY NOT EXCEED 
THE AMOUNT YOU PAID FOR THE PRODUCT THAT IS THE SUBJECT OF 
A CLAIM. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR 
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE 
PRECEDING EXCLUSION OR LIMITATION MAY NOT APPLY TO YOU.

The limited warranty on a Product may be transferred for the remaining term if the 
then current owner transfers ownership of the Product and notifies LeCroy of the 
transfer. You may notify LeCroy of the transfer by writing to Technical Support at 
LeCroy, 3385 Scott Blvd., Santa Clara, CA 95054 USA or by email at: 
support@catc.com. Please include the transferring owner's name and address, the 
name and address of the new owner, the date of transfer, and the Product serial 
number.
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recording 76
Bus Usage option 150
Bus Utilization

buttons 144
report 143

Bus Utilization option 83
BusEngine 8

manual updating 31
technology 8
update 28

buttons
action 73
bus utilization 144
navigator 108
real-time statistics 148
Script Editor 155
tool bar descriptions 40

Bytes box 51

C
cable

connector 22
Cables 24
CATC Trace

recording 16
set marker 92

Change Counter Value command 72
Channel

search 135
channel

trigger/filter 51
Check Syntax command 36
Chirp Reset Length option 57

chirps
hiding 97

class decoding keys 172
class definition files 111
Class Request
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rework area 23
Right click cell context menu option 82
right module slot 20
RPipe field 118, 121
RPipes 118, 120

endpoints 119
rules

recording 8

S
save

Display Options 89
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Token Patterns event group 60
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firmware manual 33
software 28
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USB On-The-Go option 56
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versions 27
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Virtual .dec file 112
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warranty

coverage 174
limited 173
period 173
provisions 175
service 174
transfer 175

website 28, 173
weight 9
window

options 36
window layout
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Window menu 38
Wire Adapter .dec file 112
Wrap command 45
Wrap option 82
Wrap.utg file 160
wrap=here line 160
wrapping lines 82

Y
Y Scale Type option 149

Z
Zip files 28
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Zoom Level option 82
Zoom out command 45
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